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KATA PENGANTAR

Puji syukur kehadirat Tuhan Yang Maha Esa, Pedoman Pemetaan Sejarah
dan Nilai Budaya telah selesai disusun. Penyusunan Pedoman Pemetaan
Sejarah dan Nilai Budaya merupakan salah program kerja Direktorat
Sejarah dan Nilai Budaya, Direktorat Jenderal Kebudayaan, Kementerian
Pendidikan dan Kebudayaan tahun anggaran 2013.

Buku ini merupakan kelanjutan dari buku pedoman Sistem Informasi
Geografis untuk Pemetaan Sejarah yang telah dicetak tahun 2010. Selain
berisi tentang prosedur dan tata cara pemetaan sejarah, buku ini juga
berisi tentang prosedur dan tata cara pemetaan nilai budaya. Buku
Pedoman Pemetaan Sejarah dan Nilai Budaya berisi tentang konsep dan
metode pemetaan, prosedur dan tata cara pemetaan, serta berisi contoh-
contoh peta yang dapat dijadikan referensi oleh semua pihak yang
berminat di bidang sejarah dan nilai budaya.

Dalam pemetaan sejarah dan nilai budaya, objek dan fenomena
kebudayaan yang berkaitan dengan suatu peristiwa masa lalu dan
kebiasaan dari sebuah komunitas tidak terlepas dari gejala geografi yang
nampak di permukaan bumi seperti: sungai, gunung, hutan, dan
sebagainya. Hubungan wujud yang saling mempengaruhi antara kedua
jenis gejala tersebut dapat diketahui melalui sebuah sistem informasi yang
mampu mengumpulkan, menyimpan, mengolah, dan menganalisa data
sejarah dan nilai budaya yang terdapat di permukaan bumi, sehingga
dapat diketahui bagaimana sebuah peristiwa yang terjadi pada masa lalu
dan akibatnya sebagai kebudayaan di masa kini.
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Buku ini telah mengalami perbaikan berdasarkan masukan dari
narasumber yang berkompeten di bidangnya. Semoga buku Pedoman
Pemetaan Sejarah dan Nilai Budaya ini dapat bermanfaat bagi semua
pihak yang berminat dalam bidang Pemetaan Sejarah dan Nilai Budaya.

Jakarta, Desember 2013
Direktur Sejarah dan Nilai Budaya

Endjat Djaenuderadjat
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BAB 1. PENDAHULUAN

1.1. Latar Belakang

Penggunaan Sistem Informasi Geografis (SIG) dalam pemetaan sejarah
dan nilai budaya dapat membantu para ahli sejarah, budaya, sosial,
pengambil keputusan, dan masyarakat awam dalam menjelaskan proses
terjadinya suatu peristiwa dan perubahan dari waktu ke waktu dalam
suatu ruang geografi. Sebuah peristiwa atau perubahan dapat ditunjukkan
dengan memetakan objek sejarah yang bersifat tetap seperti: rumah,
pemukiman, jalan, dan lainnya, maupun melakukan rekontruksi gejala
yang pernah terjadi pada masa lalu di suatu tempat.

Dalam pemetaan sejarah dan nilai budaya, objek dan fenomena
kebudayaan yang berkaitan dengan suatu peristiwa masa lalu dan
kebiasaan dari sebuah komunitas tidak terlepas dari gejala geografi yang
nampak di permukaan bumi seperti: sungai, gunung, hutan, dan
sebagainya. Hubungan wujud yang saling mempengaruhi antara kedua
jenis gejala tersebut dapat diketahui melalui sebuah sistem informasi yang
mampu mengumpulkan, menyimpan, mengolah, dan menganalisa data
sejarah dan nilai budaya yang terdapat di permukaan bumi, sehingga
dapat diketahui bagaimana sebuah peristiwa yang terjadi pada masa lalu
dan akibatnya sebagai kebudayaan di masa kini.

Oleh karena itu, sebuah peta sejarah dan kebudayaan yang dibuat dengan
menggunakan SIG akan mampu menjelaskan lokasi, persebaran,
pergerakan, keluasan, batas-batas, dan hubungan antar unsur-unsur
tersebut serta perubahan yang terjadi dalam sebuah kurun waktu atau
beberapa kurun waktu. Secara luas, hasil pemetaan sejarah dan nilai
budaya dengan SIG akan mampu memberikan sumbangan bagi dunia
pendidikan, penelitian, pariwisata, dan dapat dijadikan sebagai acuan
dalam penyusunan kebijakan publik.
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Untuk melakukan pemetaan sejarah dan nilai budaya dengan
menggunakan SIG yang memiliki standar nasional, maka Direktorat
Sejarah dan Nilai Budaya menganggap perlu menyusun pedoman ini agar
dapat dijadikan acuan bagi siapapun yang melakukan pembuatan peta
sejarah dan nilai budaya.

Sistem Informasi Geografis (Geographic Information System/GIS) yang
selanjutnya akan disebut SIG merupakan sistem informasi berbasis
komputer yang digunakan untuk mengolah dan menyimpan data atau
informasi geografis (Aronoff, 1989). SIG akan selalu diasosiasikan dengan
sistem yang berbasis komputer, walaupun pada dasarnya SIG dapat
dikerjakan secara manual, SIG yang berbasis komputer akan sangat
membantu ketika data geografis merupakan data yang besar (dalam
jumlah dan ukuran) dan terdiri dari banyak tema yang saling berkaitan.

1.2. Landasan
A. UU No. 4 Tahun 2011 Tentang Informasi Geospasial

Pasal 1, Ayat 4 :

Informasi Geospasial yang selanjutnya disingkat |G adalah data geospasial
(DG) yang sudah diolah sehingga dapat digunakan sebagai alat bantu
dalam perumusan kebijakan, pengambilan keputusan, dan/atau
pelaksanaan kegiatan yang berhubungan dengan ruang kebumian.

Pasal 1, Ayat6:

Informasi Geospasial Tematik yang selanjutnya disingkat IGT adalah IG
yang menggambarkan satu atau lebih tema tertentu yang dibuat mengacu
pada Informasi Geospasial Dasar (IGD).
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Pasal 7 :

Peta dasar sebagaimana dimaksud dalam Pasal 5 huruf b berupa:
a. Peta Rupabumi Indonesia;
b. Peta Lingkungan Pantai Indonesia; dan
c. Peta Lingkungan Laut Nasional.

Pasal 20 :

Dalam membuat IGT dilarang:

a. mengubah posisi dan tingkat ketelitian geometris bagian 1GD;
dan/atau

b. membuat skala IGT lebih besar daripada skala IGD yang
diacunya.

Pasal 21:

1) IGT yang menggambarkan suatu batas yang mempunyai kekuatan
hukum dibuat berdasarkan dokumen penetapan batas secara
pasti oleh Instansi Pemerintah yang berwenang.

2) Penetapan batas yang dibuat oleh Instansi Pemerintah dan/atau
Pemerintah daerah yang berwenang dilampiri dengan dokumen
IGT yang akurat dan dapat dipertanggungjawabkan.

3) Dalam hal terdapat batas yang belum ditetapkan secara pasti oleh
Instansi Pemerintah yang berwenang sebagaimana dimaksud
pada ayat (1), digunakan batas sementara yang penggambarannya
dibedakan dengan menggunakan simbol dan/atau warna khusus.
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Pasal 23 :

1)

2)

3)

4)

IG yang berjenis IGT sebagaimana dimaksud dalam Pasal 4 huruf b
dapat diselenggarakan oleh Instansi Pemerintah, Pemerintah
daerah, dan/atau setiap orang.

Instansi  Pemerintah  atau  Pemerintah  daerah  dalam
menyelenggarakan IGT  berdasarkan tugas, fungsi, dan
kewenangannya sesuai dengan ketentuan peraturan perundang-
undangan.

Instansi Pemerintah atau Pemerintah daerah sebagaimana
dimaksud pada ayat (2) dalam menyelenggarakan IGT dapat
bekerja sama dengan Badan.

Setiap orang dapat menyelenggarakan IGT hanya untuk
kepentingan sendiri dan selain yang diselenggarakan oleh Instansi
Pemerintah atau Pemerintah daerah.

Pasal 24

(1) Badan dapat mengintegrasikan:

a.

lebih dari satu IGT yang diselenggarakan oleh Instansi Pemerintah
atau Pemerintah daerah menjadi satu IGT baru; dan

IGT yang diselenggarakan oleh lebih dari satu Instansi Pemerintah
dan/atau Pemerintah daerah menjadi satu IGT baru.

(2) Badan dapat menyelenggarakan IGT dalam hal IGT yang belum

diselenggarakan oleh Instansi Pemerintah selain Badan atau yang
belum diselenggarakan oleh Pemerintah daerah.
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B. UU No. 26 Tahun 2007 Tentang Penataan Ruang
Pasal 5, Ayat 2C:

Kawasan suaka alam dan cagar budaya, antara lain, kawasan suaka alam,
kawasan suaka alam laut dan perairan lainnya, kawasan pantai berhutan
bakau, taman nasional, taman hutan raya, taman wisata alam, cagar alam,
suaka margasatwa, serta kawasan cagar budaya dan ilmu pengetahuan;

Pasal 5, Ayat 3 :

Hak prioritas pertama bagi pemerintah dan pemerintah daerah
dimaksudkan agar dalam pelaksanaan pembangunan kepentingan umum
yang sesuai dengan rencana tata ruang dapat dilaksanakan dengan proses
pengadaan tanah yang mudah. Pembangunan bagi kepentingan umum
yang dilaksanakan pemerintah atau pemerintah daerah meliputi:

a. jalan umum dan jalan tol, rel kereta api (di atas tanah, di ruang
atas tanah, ataupun di ruang bawah tanah), saluran air minum/air
bersih, saluran pembuangan air dan sanitasi;

b. waduk, bendungan, bendungan irigasi, dan bangunan pengairan
lainnya;

c. pelabuhan, bandar udara, stasiun kereta api, dan terminal;

d. fasilitas keselamatan umum, seperti tanggul penanggulangan
bahaya banjir, lahar, dan lain-lain bencana;

e. tempat pembuangan sampabh;
f. cagar alam dan cagar budaya; dan

g. pembangkit, transmisi, dan distribusi tenaga listrik.
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C. UU no. 11 tahun 2010 Tentang Cagar Budaya
Pasal 1:

1. Cagar Budaya adalah warisan budaya bersifat kebendaan
berupa Benda Cagar Budaya, Bangunan Cagar Budaya, Struktur
Cagar Budaya, Situs Cagar Budaya, dan Kawasan Cagar Budaya
di darat dan/atau di air yang perlu dilestarikan keberadaannya
karena memiliki nilai penting bagi sejarah, ilmu pengetahuan,
pendidikan,  agama, dan/atau kebudayaan melalui proses
penetapan.

2. Benda Cagar Budaya adalah benda alam dan/atau benda
buatan manusia, baik bergerak maupun tidak bergerak, berupa
kesatuan atau kelompok, atau bagian-bagiannya, atau sisa-
sisanya yang memiliki hubungan erat dengan kebudayaan dan
sejarah perkembangan manusia.

3. Bangunan Cagar Budaya adalah susunan binaan yang terbuat
dari benda alam atau benda buatan manusia untuk memenuhi
kebutuhan ruang berdinding dan/atau tidak berdinding, dan
beratap.

4. Struktur Cagar Budaya adalah susunan binaan yang terbuat dari
benda alam dan/atau benda buatan manusia untuk memenuhi
kebutuhan ruang kegiatan yang menyatu dengan alam, sarana,
dan prasarana untuk menampung kebutuhan manusia.

5. Situs Cagar Budaya adalah lokasi yang berada di darat
dan/atau di air yang mengandung Benda Cagar Budaya, Bangunan
Cagar Budaya, dan/atau Struktur Cagar Budaya sebagai hasil
kegiatan manusia atau bukti kejadian pada masa lalu.
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Kawasan Cagar Budaya adalah satuan ruang geografis yang memiliki
dua Situs Cagar Budaya atau lebih yang letaknya berdekatan
dan/atau memperlihatkan ciri tata ruang yang khas.

D. Instruksi Presiden Republik Indonesia Nomor 6 Tahun 2012 Tentang
Penyediaan, Penggunaan, Pengendalian Kualitas, Pengolahan Dan
Distribusi Data Satelit Penginderaan Jauh Resolusi Tinggi.

PERTAMA : Menggunakan citra tegak satelit penginderaan jauh
resolusi tinggi yang disediakan oleh Badan Informasi Geospasial
berdasarkan data satelit penginderaan jauh resolusi tinggi dengan
ukuran piksel lebih kecil dan/atau sama dengan 4 (empat) meter yang
disediakan oleh Lembaga Penerbangan dan Antariksa Nasional.

1.3. Tujuan

Membuat standar mengenai metode, sistem dan teknik pengumpulan
data, analisa, dan pembuatan peta sejarah dan nilai budaya sesuai standar
pemetaan nasional.

1.4. Ruang Lingkup

Lingkup dalam pedoman ini meliputi prosedur dan tata cara pelaksanaan
kegiatan pemetaan sejarah dan nilai budaya dengan penggunaaan
pendekatan keruangan, persyaratan teknis bahan, peralatan penunjang
kegiatan, persyaratan teknis pembuatan peta, serta kualifikasi personil
dalam melaksanakan setiap jenis kegiatan dalam pengumpulan dan
pengolahan data dalam rangka pembuatan peta analog dan peta digital
sejarah dan nilai budaya dengan menggunakan aplikasi SIG.
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BAB 2. KONSEP DAN METODE

2.1. Pemetaan Sejarah dan Nilai Budaya

2.1.1, Aspek Geografi Sejarah dan Nilai Budaya
Sebagai sebuah ilmu, “sejarah” menaruh perhatian pada penyelidikan

terhadap dinamika kehidupan manusia dalam kaitannya dengan peristiwa

dan kejadian di masa lalu. Sejarah berkewajiban memberikan penafsiran

tentang masa lalu. Jadi sejarah pada dasarnya merupakan sebuah bahasa
ide. Karena merupakan tafsiran, maka dapat dikatakan juga bahwa
sejarah adalah sebuah proses pemikiran yang diupayakan oleh manusia
untuk memahami diri dan lingkungannya melalui pemahaman akan
kejadian-kejadian lampau dalam suatu kerangka waktu. Frederick &
Soeroto (2005) menyatakan bahwa pemikiran sejarah paling tidak
mengandung 3 (tiga) unsur utama, yaitu :

o Waktu sebagai pangkal pemikiran sejarah. Dengan menerapkan
unsur waktu maka masa lampau akan dapat diukur secara tepat.
Oleh sebab itu unsur waktu bersifat mutlak. Para ahli sejarah
memandang waktu sebagai sesuatu yang berjalan secara langgeng
dan teratur. Setiap penggal perjalanan waktu harus dapat
diuraikan sesuai dengan ciri khasnya sehingga dapat memberikan
kerangka guna menafsirkan masa lampau.

e Fakta baik berupa keterangan yang bersifat abstrak maupun
mutlak. Fakta merupakan unsur penting guna menarik makna
tertentu yang paling mendekati kebenaran dalam memahami
masa lampau. Dengan demikian, fakta bukan merupakan sesuatu
yang dapat diterima begitu saja, melainkan harus dipahami secara
menyeluruh dan diperlakukan secara hati-hati.

e Kausalitas antara beberapa kejadian dalam waktu vyang
bersamaan atau berurutan. Pengungkapan hubungan sebab

8
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akibat akan menguraikan “kerumitan” masa lampau sehingga
dapat menghasilkan pendapat tentang kaitan antara berbagai
kejadian. Hal ini antara lain didasarkan oleh adanya kesadaran
tidak ada penyebab tunggal dalam kemunculan suatu kejadian.
Dengan demikian, pemikiran sejarah bukan saja menjawab kapan
suatu kejadian terjadi, tetapi juga mengapa dan bagaimana
terjadinya.

Dalam falsafah keilmuan, “ruang (space)” dan “waktu (time)” selalu
dipandang secara terintregrasi. Oleh sebab itu kondisi timeless space dan
spaceless time tidak diakui keberadaaanya. Samuel Alexander, seorang
ahli filsafat asal Inggris, pada tahun 1920 menyatakan: “all vital problems
of philosophy depend for their solution of the problem of what ‘space’ and
‘time’ are and more particularly how they are related to each other”.
Meskipun ungkapan di atas dinyatakan dalam konteks filsafat ilmu,
konsep ruang dan waktu selalu dibutuhkan manusia dalam kehidupan
sehari-hari. Dalam berbagai aktivitasnya, manusia selalu melakukan
organisasi ruang dan waktu. Dengan demikian, pengembangan ilmu
pengetahuan perlu memperlakukan kedua konsep tersebut secara lebih
nyata demi kemajuan kehidupan manusia.

Menurut disiplin keilmuannya, ilmu geografi selalu berkaitan dengan
persoalan ruang, sedangkan ilmu sejarah selalu berkaitan dengan
persoalan waktu. Dalam berbagai kasus di Indonesia, kedua ilmu tersebut
seringkali berjalan secara terpisah. Padahal, sebagaimana dinyatakan oleh
Meinig (1978), geografi dan sejarah sebenarnya berakar pada satu hal
yang sama.

“Geography and history are rooted in the basic stuff of human existence.
As field of study they are analogues, complementary, and
interdependence. Their relationship is implied by such common terms as
space and time, places, events — pairs that are fundamentally inseparable”
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Oleh karenanya, antara kedua disiplin tersebut tercipta hubungan saling
melengkapi dan saling ketergantungan. Soemarsaid Martono (dalam De
Graff & Pigeaud, 2003) menyatakan bahwa penelitian sejarah selalu
memerlukan kejelasan akan batas temporal dan spasial sehingga
diperoleh gambaran sebab akibat yang utuh, tuntas, dan tidak timpang.
Selanjutnya, Lombard (2005) juga menyatakan bahwa tak satu pun
ancangan sejarah akan mencapai tujuannya tanpa memperhatikan faktor
geografis.

Pada sisi lain, Ogilvie (1952) mengungkapkan tentang pentingnya elemen
waktu dalam kajian geografi. la menyatakan: because geography is
concerned primarily with space rather time, we are inclined to take the
time-element inherent in our own work. Dalam kaitannya tersebut
Hartshorne (1959) menyatakan bahwa dimensi waktu memiliki peran
penting dalam analisis geografi, antara lain:

e Untuk mendapatkan penjelasan atau deskripsi yang representatif
mengenai siklus atau fluktuasi fenomena tertentu dalam suatu
periode pada "saat ini”.

e Untuk menentukan kecenderungan saat ini sebagai dampak
kumulatif dari perubahan yang terjadi di masa lalu dalam waktu
yang relatif panjang.

e Untuk mengkaji keterkaitan antar gejala yang terjadi pada masa
kini melalui pemahaman terhadap keterkaitan serupa yang
tercipta di masa lalu namun dengan karakter yang berbeda

Butlin (1992) menyatakan ”geografi sejarah” adalah kajian geografis
tentang masa lampau atau study of the geographies of past time. Kajian
tersebut dilakukan melalui rekonstruksi imajinatif dalam suatu rentang
waktu dengan menekankan pada pemahaman integratif terhadap
dinamika kehidupan dalam suatu area. Adapun hal yang menjadi pusat
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perhatian dalam kajian geografi sejarah adalah fenomena atau proses
keruangan yang menggambarkan dinamika keterkaitan antara manusia-
lingkungan antara lain dalam hal memanfaatkan sumberdaya alam,
membangun permukiman, mengembangkan kekuasaan, mengontrol
teritori, dan sebagainya.

Nilai budaya merupakan sebuah nilai yang muncul dari konsepsi-konsepsi
alam pikiran manusia. Carl O. Sauer menyatakan bahwa geografi budaya
adalah ilmu pengetahuan yang menelaah sekitar tingkah laku yang
ditimbulkan karena adanya usaha adaptasi dan pemanfaatan lingkungan
alam oleh manusia dalam usaha mempertahankan hidupnya. Budaya pada
umumnya condong menggambarkan karakteristik suatu wilayah yang
biasanya dibatasi oleh kondisi fisik suatu wilayah, misalnya di wilayah
pesisir memiliki mata pencaharian sebagai nelayan karena masyarakat
tersebut berusaha mensiasati alam sebagai sumber kehidupannya dengan
menciptakan alat-alat penangkap ikan yang merupakan pencerminan
budaya setempat.

Unsur kebudayaan menurut Koentjaraningrat terdiri dari tujuh unsur yang
dapat menunjukkan perbedaan budaya dari satu daerah dengan daerah
lainnya. Ketujuh unsur kebudayaan tersebut antara lain:

1. Religi

2. Kekerabatan

3. Sistem Pengetahuan
4, Bahasa

5. Kesenian

6. Mata Pencaharian

7. Teknologi
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Dari ketujuh unsur kebudayaan di atas, maka perwujudan dari sebuah
kebudayaan dapat dilihat dari munculnya gagasan/ide/nilai yang ada di
suatu wilayah sehingga membentuk sebuah sistem sosial di masyarakat.
Woujud kebudayaan lain yang bersifat fisik juga dapat dilihat dari bentuk-
bentuk bangunan di suatu wilayah yang pada umumnya mencerminkan
pedoman hidup bermasyarakat. Contoh: Pada bagian atas gerbang
menggunakan listplank gigi balang yang merupakan ciri khas bangunan
Betawi. Listpank gigi balang terdiri dari bentuk segitiga dan bulatan dan
mempunyai makna kejujuran, keberanian, keuletan dan kesabaran.
Lisplang gigi balang dibentuk dengan ornamen segitiga berjajar dan
menggunakan material papan kayu.

Gambar 1. Bangunan Betawi yang memiliki Listplank Gigi Balang.

Pemetaan nilai budaya berfungsi untuk menggambarkan berbagai unsur
kebudayaan yang mencerminkan adanya konsep kehidupan yang khas
secara keruangan sehingga tergambar perbedaan dan kemiripan nilai

budaya dari suatu wilayah dengan wilayah lainnya. Setiap wujud
12
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kebudayaan  dapat  menjelaskan/mengandung  beberapa  unsur
kebudayaan sekaligus sehingga dari setiap wujud kebudayaan dapat
diperoleh berbagai macam informasi mengenai nilai-nilai budaya yang
terdapat di dalamnya. Hasil pemetaan tidak dapat mengungkap “nilai
budaya” jika tidak dilengkapi dengan penjelasan dan penafsiran dari si
pembuat peta.

Carl O. Sauer mengungkapkan beberapa tema yang dapat diangkat dalam
kajian geografi sejarah dan budaya. Tema-tema tersebut antara lain
adalah :

1. Gejala geografi fisik tertentu yang mempengaruhi perubahan
muka bumi seperti halnya perubahan iklim yang diakibatkan oleh
manusia dan kembali menimbulkan dampak terhadap manusia,
perubahan-perubahan gejala alami pada bagian tertentu yang
mengakibatkan perubahan tutupan vegetasi, atau tentang gejala
alami lainnya (perubahan garis pantai, perubahan pola tata air,
dsb).

2. Kajian tentang manusia beserta perilakunya yang mengakibatkan
perubahan alam.

3. Kajian tentang tata letak permukiman, tipologi perumahan, dan
pola permukiman yang antara lain berkaitan erat dengan nilai
budaya dan cara pandang manusia dalam mengatasi kendala fisik
dan sosial.

4. Pengelolaan sumberdaya alam kepemilikan, penguasaan, dan
pengambilan keputusan dalam kaitannya dengan dinamika
struktur sosial politik dalam lingkup budaya tertentu.

5. Perkembangan atau siklus kebudayaan yang memunculkan pusat-
pusat peradaban sehubungan dengan perkembangan penduduk,
kemajuan teknologi, dan dinamika daya dukung lingkungan.

13

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



6. Pola-pola pembauran antar kelompok masyarakat yang dikaitkan
dengan difusi informasi dan pengetahuan dari satu tempat ke
tempat lain. Termasuk memberikan penjelasan mengenai
kemampuan masyarakat dalam menerima nilai budaya baru

7. Konflik-konflik teritorial yang berkaitan dengan adanya kelompok
dominan yang bersifat agresif dan kelompok marjinal baik dalam
konteks politik, ekonomi, maupun sosial.

2.1.2. Teknologi Pemetaan

Teknologi pemetaan saat ini telah berkembang pesat dari era
konvensional menuju era dijital (komputerisasi). Alih teknologi analog
(konvensional) ke sistem komputerisasi (dijital) dalam hal pemetaan ini
dimulai pada awal 80-an dengan suatu sistem dijital yang lebih disebut
dengan Sistem Informasi Geografis (SIG).

Berkaitan dengan pemetaan sejarah dan nilai budaya, ada dua elemen
penting yang menjadi dasar dari sejarah ini yaitu: ruang dan waktu. Ruang
berkaitan erat dengan kondisi sekitar obyek, dapat berupa suatu satuan
batasan administrasi maupun batasan abstrak di bumi ini. Sementara
waktu sangat berkaitan erat dengan deskripsi obyek yang dipetakan.
Kedua elemen ini secara kebetulan juga merupakan elemen dasar dari
SIG, dimana sistem ini mampu memadukan informasi ruang yang
berkaitan dengan posisi dan segala sesuatunya yang berkaitan dengan
tempat, serta dimensi waktu vyang berkaitan erat dengan
atribut/informasi/deskripsi detil dari setiap obyek (obyek sejarah dan nilai
budaya)

Data dan informasi geografis yang dimiliki oleh SIG tersimpan dalam
bentuk dijital dalam komputer dengan kapasitas yang sangat besar.
Dengan kemajuan teknologi komputer, media penyimpan data dijital
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dengan kapasitas besar banyak tersedia dengan harga yang makin lama
makin murah.

Sistem ini makin lama makin sempurna dan canggih sehingga SIG tidak
hanya digunakan oleh mereka yang berkecimpung di bidang ilmu
kebumian saja, tetapi SIG sudah banyak dibutuhkan oleh para pelaksana
dan praktisi dalam berbagai bidang.

SIG mempunyai kemampuan untuk menghubungkan berbagai data pada
suatu titik tertentu di bumi, menggabungkannya, menganalisa dan
akhirnya memetakan hasilnya. Aplikasi SIG menjawab beberapa
pertanyaan seperti: lokasi, kondisi, trend, pola, dan pemodelan/prediksi.
Kemampuan inilah yang membedakan SIG dari sistem informasi lainnya.
Dilihat dari definisinya, SIG adalah suatu sistem yang terdiri dari berbagai
komponen yang tidak dapat berdiri sendiri-sendiri. Memiliki perangkat
keras komputer beserta dengan perangkat lunaknya belum berarti bahwa
kita sudah memiliki SIG apabila data geografis dan sumberdaya manusia
yang mengoperasikannya belum ada. Sebagaimana sistem komputer pada
umumnya, SIG hanyalah sebuah ‘alat’ yang mempunyai kemampuan
khusus. Kemampuan sumberdaya manusia untuk memformulasikan
persoalan dan menganalisa hasil akhir sangat berperan dalam
keberhasilan SIG.

Data yang dikelola SIG terdiri dari dua jenis, yang pertama, data spasial
adalah data yang mempunyai dimensi ruang/space yang disajikan dalam
suatu peta. Data ini merupakan data ruang muka bumi yang apabila
disajikan pada peta dapat menunjukkan posisi dan menerangkan tentang
lokasi geografis, misalnya: lokasi danau, lokasi jalan tol dan sebagainya.
Dalam penyajiannya, setiap data spasial tersebut disertai dengan label
sebagai keterangan dari apa yang disajikan. Selain menunjukkan posisi,
data ini juga menggambarkan obyek dan fenomena geografisnya. Obyek
mengacu pada lokasi di permukaan bumi dengan menggunakan sistem
koordinat (x dan y). Sedangkan fenomena geografis dapat berupa konsep
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fenomenologis, seperti : kota, sungai, dataran rendah/tinggi, bentuk serta
struktur tanah dan sebagainya.

Jenis data kedua adalah data non spasial, disebut juga data atribut,
merupakan data deskriptif yaitu data kualitatif (nama, jenis, tipe, dan
lainnya) atau data kuantitatif (angka satuan/besaran/ jumlah, tingkatan,
klas, interval, dan lainnya) yang mempunyai hubungan satu-satu dengan
data grafisnya. Data non spasial dapat diperoleh melalui data statistik
maupun keterangan lainnya yang dapat dipergunakan sebagai
kelengkapan informasi dari data spasial.

Dalam input data, data spasial dan data atribut harus dihubungkan secara
benar (atribut harus terkait secara logis dengan obyek spasial yang
dijelaskan). Bentuk data non spasial fungsinya tidak menunjukkan lokasi
suatu obyek, tetapi memberikan informasi deskriptif dan menjelaskan
identitas suatu obyek (misalnya: nama jalan, lebar jalan, kadar garam di
danau dan sebagainya).

Teknologi yang digunakan dalam SIG dapat dikelompokkan ke dalam tiga
kategori berdasarkan prosesnya, yaitu:

1. Teknologi Pengambilan dan Pemasukan Data

Teknologi ini terdiri dari alat-alat yang digunakan oleh surveior
dan operator SIG dalam proses pengambilan data di lapangan
ataupun memasukkan data spasial kedalam basisdata geospasial.
Global Positioning Systems (GPS) digunakan jika pengambilan data
dilakukan secara langsung di lapangan dan menghasilkan data
berupa titik koordinat dan jalur perjalanan.

Bila surveior tidak dapat mencapai lokasi yang harus di survei,
maka teknologi yang dapat diandalkan adalah penginderaan jauh
dimana obyek yang akan dipetakan dapat diindera menggunakan
teknologi citra satelit ataupun foto udara. Teknologi penginderaan

16

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



jauh juga dapat digunakan untuk mendapatkan informasi masa
lalu dengan memanfaatkan data akuisisi citra pada masa lampau
(terbatas hingga waktu dimulainya satelit beroperasi).

Definisi dari penginderaan jauh adalah:

‘Pengambilan atau pengukuran data/informasi mengenai sifat
dari sebuah fenomena, obyek atau benda dengan menggunakan
sebuah alat perekam tanpa berhubungan langsung dengan bahan
studi’

Seperti halnya dengan foto yang dihasilkan oleh kamera biasa,
foto/citra satelit juga memberikan gambaran permukaan bumi
yang dihasilkan dari sensor satelit yang mendasarkan pada
perekaman dengan menggunakan spektrum elektromagnetik yang
lebih luas daripada spektrum yang digunakan untuk keperluan
fotografi darat (ground photography). Karena sifat inilah maka
data foto/citra satelit dapat diekstrak menjadi data turunan yang
dapat dimanfaatkan luas untuk berbagai keperluan aplikasi.

Variasi kedetilan obyek yang digambarkan dalam citra/foto satelit
disebut dengan resolusi spasial atau lebih tepatnya adalah ukuran
obyek di permukaan bumi terkecil yang dapat direkam oleh
sensor satelit. Ukuran ini sering disebut dengan piksel sebagai
bahasa aplikasi dijitalnya.

Perkembangan teknologi penginderaan jauh ini juga sangat pesat
seperti halnya dengan perkembangan perangkat lunak SIG atau
basis dijital lainnya. Jenis kedetilan dari citra satelit yang bervariasi
saat ini tentu saja dapat dimanfaatkan untuk kepentingan studi
sejarah tergantung pada unit interpretasi yang digunakan.

Sebagai gambaran contoh dari data ini adalah sebagai berikut:
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Tabel 1. Contoh citra satelit yang umum digunakan dalam pemetaan.

Citra disamping adalah citra Landsat7 ETM+,
citra ini adalah citra dari satelit yang
dioperasikan oleh NASA dengan resolusi 30
m dan 15 m. Ekstraksi informasi dari citra ini
adalah: informasi penutup dan penggunaan
lahan, informasi ekosistem, informasi
kondisi geomorfologis, dan beberapa
turunan lainnyan yang dilakukan dengan

serangkaian operasi pengolahan citra.

Citra Quick Bird, merupakan citra satelit
yang dikelola oleh pihak swasta. Citra ini
memiliki resolusi spasial yang sangat tinggi
yaitu 1,4 m dan 60 cm. Pada studi-studi
sejarah dan arkeologi, citra ini mampu
memberikan informasi detil mengenai
kondisi suatu situs arkeologi dan elemen-
elemen sejarah lainnya.

Selain memanfaatkan data lapangan menggunakan GPS dan citra
satelit atau foto udara, proses memasukkan data spasial kedalam
format SIG dapat pula menggunakan fasilitas pemetaan berbasis
internet (internet mapping). Salah satu aplikasi pemetaan berbasis
internet yang sifatnya terbuka penggunaannya adalah
OpenStreetMap (www.openstreetmap.org), dimana metode
pemetaan yang diadopsi adalah pemetaan kolaboratif berbasis

komunitas. Dalam aplikasi OpenStreetMap, pengguna yang sudah
terdaftar dapat melakukan proses memasukkan data berupa: data
spasial jaringan jalan, jaringan sungai, dan titik obyek penting.
Data yang sudah tersimpan dalam server OpenStreetMap bersifat
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terbuka dan setiap pengguna memiliki kemampuan untuk
menambah dan mengedit data yang ada.

2. Teknologi Pengolahan Data

Teknologi pengolahan data meliputi penggunaan perangkat lunak
SIG dan perangkat keras komputer yang memiliki kemampuan
untuk menyimpan, mengolah, dan menganalisa data spasial.
Teknologi ini merupakan inti dari SIG, dimana operator SIG dapat
mengolah data lapangan atau data masukan menjadi informasi
melalui proses simbolisasi sehingga mudah dipahami oleh
pengguna peta.

3. Teknologi Publikasi Informasi

Teknologi publikasi pemetaan dapat dibagi menjadi dua tipe, yaitu
cetak dan non cetak. Untuk teknologi cetak, yang dibutuhkan
adalah alat cetak (printer) yang memiliki resolusi warna yang
mendekati dengan resolusi yang ada pada layar monitor.
Sedangkan untuk teknologi non cetak pada umumnya mengarah
kepada teknologi pemetaan berbasis web dimana informasi yang
didapat dipublikasikan melalui sebuah web yang interaktif.

Setiap fenomena sejarah dan budaya yang terjadi di permukaan bumi
dapat digambarkan dengan menggunakan SIG sehingga dapat membantu
sejarawan dan budayawan dalam menjelaskan proses yang terjadi di masa
lalu dan menghasilkan budaya yang telah menghilang dan yang masih ada
hingga masa kini.
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2.2. Metode Pemetaan Sejarah

2.2.1. Pemilihan Topik

Topik merujuk pada fenomena sejarah yang akan dipetakan. Setelah
ditentukan topik yang akan dipetakan, kemudian dirumuskanlah rencana
kerja untuk mencapai hasil yang diharapkan.

Lingkungan fisik yang selalu berubah sepanjang waktu seperti: perubahan
garis pantai, sejarah geologis, dan perubahan sungai purba merupakan
fenomena sejarah yang dapat menjelaskan tentang sejarah terbentuknya
suatu wilayah. Selain dari lingkungan fisik yang berubah, fenomena
kehidupan manusia yang tinggal di dalam suatu wilayah juga dapat
menceritakan sebuah fakta sejarah, seperti: perpindahan penduduk, situs
sejarah, perkembangan kota, dan lain-lain.
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Jaman dulu wilayah Pati belum tampak jelas
karena masih dipisahkan oleh Selat Muria

Jepara

Semarang

Jaman sekarang wilayah Pati tampak jelas
Bekas Selat Muria menyempit karena pengendapan
lumpur sehingga daratan Pulau Muria menyatu dengan
daratan Pulau Jawa

Gambar 2. Perubahan lingkungan fisik wilayah Pati

2.2.2. Pengumpulan Sumber

Pengumpulan sumber sejarah dapat diperoleh dari beberapa sumber,
seperti: kantor-kantor arsip yang dikelola oleh pemerintah, pribadi (arsip
para kyai, mantan lurah, juru kunci, dll.) atau kelompok masyarakat
tertentu, misalnya: arsip keraton, arsip pesantren, arsip gereja, dan
museum.
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Sumber sejarah dan budaya terbagi atas data tertulis dan lisan. Sumber
tertulis dapat diperoleh dari perpustakaan dalam bentuk buku, dokumen,
koran dan sebagainya sedangkan sumber lisan dapat diperoleh dengan
menggunakan metode wawancara, dengan maksud untuk mengungkap
peristiwa masa lalu yang dialami, dilihat dan didengar oleh informan.
Sejalan dengan perkembangan teknologi, sumber sejarah dapat juga
menggunakan media audio visual.

2.2.3. Pemetaan

Berdasarkan sumber-sumber yang telah dikumpulkan, proses selanjutnya
adalah memetakan fenomena-fenomena sejarah telah direncanakan
seperti: lokasi situs pra sejarah, bangunan-bangunan bersejarah, jalur
perjalanan gerilya, dan lain-lain.

Proses pemetaan bisa dilakukan dalam dua cara, yaitu dengan pemetaan
langsung di lapangan dengan menggunakan GPS, sketsa, dan alat ukur
lainnya berdasarkan data yang telah dikumpulkan sebelumnya. GPS
memberikan data mengenai lokasi absolut dari sebuah lokasi dalam
bentuk titik koordinat sehingga dapat dengan mudah dipetakan. Selain
data berupa titik, GPS juga dapat digunakan untuk memetakan jalur
perjalanan yang dapat merepresentasikan jalur perjalanan masa lalu yang
sebelumnya didapat dari literatur atau referensi lainnya dengan
menggunakan fasilitas Tracking yang ada pada GPS.

Cara yang kedua adalah dengan menggunakan teknologi penginderaan
jauh dan model prediksi. Pada metode ini operator SIG tidak secara
langsung mendatangi lapangan, akan tetapi data didapat dari citra satelit
atau foto udara yang menggambarkan wilayah masa lalu. Dengan
menggabungkan data penginderaan jauh dengan literatur atau
keterangan dari masyarakat setempat, operator SIG dapat dengan
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langsung menggambarkan pada peta dengan menggunakan simbol-
simbol.

2.2.4. Verifikasi
Langkah selanjutnya adalah kritik data atau verifikasi yang meliputi
verifikasi otentisitas dan kredibilitas.

I.  Otentisitas data tertulis diarahkan untuk menguji keaslian data.
Untuk menguiji hal tersebut diajukanlah pertanyaan berikut:

1) Kapan : menerangkan waktu suatu data peristiwa
diambil;
2) Dimana : menerangkan ruang atau tempat

berlangsungnya gejala suatu data yang diambil;

3) Siapa : menerangkan individu atau instansi/ lembaga
pembuat peta;

4) Jenis Media  : menerangkan metode pemetaan yang digunakan
termasuk dalam analisis data.

Il.  Kredibilitas digunakan untuk menilai kesahihan informasi atau
sumber sejarah (lisan).

2,2.5. Interpretasi

Setelah mengalami proses verifikasi dilanjutkan dengan proses
interpretasi atau penafsiran yang meliputi dua kegiatan yaitu, analisis dan
sintesis.
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Analisis secara harfiah berarti menguraikan data menurut komponen-
komponennya. Misalnya, Peristiwa Pemberontakan buruh pabrik gula
dengan ditemukannya informasi tentang daftar nama pekerja.

Sintesis yang berarti menyatukan. Proses ini menghubung-hubungkan
data sehingga memiliki keterkaitan dan makna. Contoh data tentang
pembunuhan, pertempuran, orang-orang mengungsi, penurunan bendera
bisa kita tafsirkan sebagai fakta bahwa di wilayah tersebut benar telah
terjadi revolusi

2.3. Metode Pemetaan Nilai Budaya

2.3.1, Pemilihan Topik

Topik merujuk pada unsur kebudayaan yang akan dipetakan. Setelah
ditentukan topik yang akan dipetakan, kemudian dirumuskanlah rencana
kerja untuk mencapai hasil yang diharapkan.

Unsur kebudayaan meliputi: religi, kekerabatan, sistem pengetahuan,
bahasa, kesenian, mata pencaharian, dan teknologi. Unsur mata
pencaharian dan teknologi merupakan unsur yang paling cepat berubah
dan membutuhkan kecepatan dan frekuensi yang tinggi dalam
pemetaannya. Sejarah dan budaya seringkali dapat dimunculkan dalam
simbol yang sama. Setiap wujud kebudayaan dapat
menjelaskan/mengandung beberapa unsur kebudayaan sekaligus.
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Tabel 2. Tabel fenomena kebudayaan

Ide/Gagasan

Wujud

Material/Wujud Fisik

Religi Dewa dapat Bertapa dan memuja Tempat-tempat
“didatangkan” pemujaan
ke bumi
Kekerabatan Kebersamaan Kumpul bersama secara Rumah berukuran
antar anggota rutin dan bergiliran besar
keluarga sangat
penting
Sistem Pengetahuan  Hutan dan mata Tidak “mengganggu” Hutan larangan
air bersifat suci hutan

Variasi bahasa

Bahasa Cara Seleksi kata dan cara
berkomunikasi mengucapkannya (bahasa ritual, bahasa
bagian dari gaul, bahasa dinas,
status sosial bahasa “halus dan
(bahasa sebagai kasar”, dsb)
identitas)
Kesenian Seni bukan Seleksi tempat dan Variasi tarian (tari

sekedar benda

waktu dalam
berkesenian

perang, tari selamat
datang, tari memuja

alam, dsb)

Mata Pencaharian Hasil kerja

Memanfaatkan

Petani, peladang,

ditentukan oleh fenomena alam untuk nelayan
kemurahan alam  membangun kehidupan
Teknologi Waktu tidak Alokasi waktu secara Jam tangan
dapat kembali tepat
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Sebelum Tahun 1982

CAMAT
MargaA MargaB
PasirahA_ Pasiran B
Dusun | . Dusun Dusun
Krio A1 . KrioA1 Krio B1

Setelah Tahun 1982

CAMAT

. DesaAf . DesaA2  DesaBt DesaB2 |

KETERANGAN

— = -~ Batas Kecamatan/Distrik
— Batas Marga
................... Batas Desa
@ Dysun - Dusun Masih dalam Satu Desa
W DU15UA -~ Dusun Kantung
o] Desa

Sumbay : Survey Lapabgan, 1930

Gambar 3. llustrasi pembagian wilayah berdasarkan marga dan hatas administratif desa

2.3.2. Pengumpulan Data

Sumber data nilai budaya dapat diperoleh dari sumber-sumber yang sama
dengan pemetaan sejarah, yang membedakan adalah jenis data yang
diperoleh. Data yang yang dikumpulkan untuk pemetaan nilai budaya
lebih menekankan pada detail wujud kebudayaan dilihat dari unsur-unsur
kebudayaan yang terkandung di dalamnya.
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Sumber data budaya terbagi atas: data tertulis, lisan, dan observasi.
Sumber tertulis dapat diperoleh dari perpustakaan dalam bentuk buku,
dokumen, koran dan sebagainya. Sumber lisan dapat diperoleh dengan
menggunakan metode wawancara, dengan maksud untuk memahami
unsur-unsur kebudayaan yang dialami/diterapkan, dilihat dan didengar
oleh informan. Sedangkan untuk sumber data dengan metode observasi
atau pengamatan didapat melalui pengalaman dari pengamat dengan
merasakan tinggal bersama sebuah komunitas dalam periode waktu
tertentu.

2.3.3. Pemetaan

Berdasarkan sumber-sumber yang telah dikumpulkan, proses selanjutnya
adalah memetakan wujud kebudayaan yang telah direncanakan. Karena
karakteristik dari kebudayaan itu tidak tetap/statis, maka wujud
kebudayaan yang akan dipetakan dibatasi pada wujud-wujud kebudayaan
yang sifatnya tidak mudah berubah. Kalau pun sering berubah, data relatif
mudah diperoleh. Kemudian wujud kebudayaan yang dipetakan juga
dapat membuka wawasan baru tentang kehidupan sehari-hari dan dapat
membantu proses pengambilan kebijakan baik itu di tingkat
lingkungan/lokal, regional, dan bahkan hingga nasional. Wujud
kebudayaan yang akan dipetakan juga harus mudah untuk dipahami oleh
publik sebagai pengguna data (end user).

Proses pemetaan yang palling umum digunakan dalam memetakan nilai
budaya vyang sifatnya tidak terlihat (intangible) adalah dengan
menggunakan metode pemetaan kolaboratif bersama masyarakat dalam
menentukan batas dan nilai-nilai budaya yang dianut oleh masyarakat
setempat. Hasil pemetaan biasanya dalam bentuk peta sketsa yang
digambar dan disepakati oleh masyarakat.
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Gate area

Gambar 4. Contoh peta sketsa hasil pemetaan partisipatif

2.3.4. Verifikasi

Langkah verifikasi pada pemetaan nilai budaya mengarah pada verifikasi
data hasil pemetaan partisipatif (sketsa) ke lapangan dengan
menggunakan teknologi SIG. Verifikasi dapat dilakukan secara langsung di
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lapangan dengan menggunakan GPS atau menggunakan citra satelit
penginderaan jauh jika kondisi di lapangan tidak memungkinkan untuk
didatangi.

Inbel Bas

i€ walking Papers it o (G

Map 0ata €2009 CC-BY-5A

Gambar 5. Peta yang digunakan dalam proses verifikasi lapangan

2.3.5. Interpretasi

Setelah mengalami proses verifikasi dilanjutkan dengan proses
interpretasi atau penafsiran yang meliputi dua kegiatan yaitu analisis dan
sintesis.

Analisis pada tahap ini berarti mencoba menggali informasi yang ada dari
data-data yang telah tergambarkan pada peta, sehingga dapat diperoleh
sebuah pola sebaran sebuah kebudayaan di suatu wilayah.
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Sintesis mengenai pola persebaran kebudayaan dapat menghasilkan
informasi lebih lanjut mengenai bagaimana sebuah kebudayaan itu

menyebar atau menghilang dan apa faktor penyebab dan
penghambatnya.
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BAB 3. PROSEDUR DAN TATA CARA

3.1. Persiapan

3.1.1, Kualifikasi Personil Survei dan Pemetaan

Menurut SK Memperindag No 426 tahun 1981, survei adalah suatu
kegiatan pemeriksaan, penelitian, pengkajian dan pengawasan atas suatu
obyek yang ditentukan dan meliputi kondisi luar, pembungkusan atau
kemasan, mutu, jumlah, ukuran-ukuran panjang, berat maupun isi dan
tanda-tanda pengenal serta persyaratan yang ditetapkan yang atas hasil
kegiatan tersebut diatas dibuktikan dengan menerbitkan laporan survei
(survei report) dan/atau sertifikat pengawasan. Dalam proses survei dan
pemetaan sejarah dan nilai budaya, kegiatan survei meliputi identifikasi
lokasi obyek-obyek bersejarah, fungsi, waktu/masa pembuatan, budaya
yang mempengaruhi, ritual, bahasa, dan data lain yang mendukung
informasi tentang sejarah dan nilai budaya.

Untuk menjalankan kegiatan survei pemetaan di bidang sejarah dan nilai
budaya maka dibutuhkan kualifikasi personil sebagai berikut:

1. Sehat fisik dan mental,

2. Ahli di bidang obyek sejarah dan nilai budaya,

3. Perhatian terhadap hal-hal yang rinci,

4, Mampu memperoleh informasi dengan jelas dan obyektif,

5. Mampu mengoperasikan dengan baik alat-alat survei lapangan
seperti: GPS, kompas, kamera dijital, alat rekam, komputer jinjing,
dan mampu membaca peta dasar,

6. Mampu menggunakan perangkat lunak pemetaan yang digunakan
untuk mengolah data survei lapangan menjadi peta,
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7. Mendapat rekomendasi dari atasannya.

Untuk mendapatkan kualifikasi yang disebutkan pada poin 2, 5, dan 6
dapat diperoleh melalui pendidikan formal atau pelatihan bersertifikat.

Adapun tugas-tugas pokok dari surveior pemetaan sejarah dan nilai
budaya adalah:

1. Melakukan pengumpulan data primer dan sekunder yang terkait
dengan fenomena sejarah dan nilai budaya,

2. Melakukan analisis untuk menentukan pola ruang dari fenomena
sejarah dan nilai budaya yang dituangkan dalam bentuk peta,

3. Menyajikan informasi dan kesaksian dalam bentuk laporan tertulis
(survei report) lengkap dengan hasil pemetaannya kepada atasan
atau pihak lain yang berwenang.

3.1.2. Peralatan

Peralatan yang akan digunakan dalam pengumpulan data primer harus
dipersiapkan secara matang. Ketidaklengkapan peralatan akan
mengganggu proses pekerjaan di lapangan. Peralatan tim yang harus
dipersiapkan meliputi:

e GPS (Global Positioning System)

Sebelum digunakan di lapangan sebaiknya GPS diuji
kemampuannya terlebih dahulu, dapat menerima sinyal satelit
menggunakan antena bawaan dan antena tambahan (bila ada)
secara bergantian. Pelajari karakter GPS tersebut sebagai dasar
pengoperasian di lapangan. Antena tambahan/eksternal
diperlukan pada saat penentuan posisi di lingkungan yang
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tertutup (di hutan, kota dengan gedung bertingkat), sehingga akan
menghalangi sinyal yang harus diterima GPS.

Gambar 6. Berbagai model GPS yang digunakan untuk survei lapangan.

Jangan gunakan baterai yang sudah hampir habis, segera tukar
dengan baterai baru. Jangan hanya mengganti satu baterai saja
karena akan melemahkan baterai yang lain (lama). Setelah
mengganti baterai, nyalakan GPS dan lihat apakah alat dapat
berfungsi dengan baik. Gunakan hanya baterai yang disyaratkan
oleh perusahaan pembuat alat. Baterai jenis alkaline lebih
dianjurkan dibandingkan baterai biasa karena memiliki
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kemampuan bertahan lama dan tidak mudah bocor. Selain itu,
bisa menggunakan baterai yang bisa diisi kembali (rechargable),
serta charger untuk melakukan isi ulang selama melakukan
kegiatan lapangan.

Periksa antena. Apabila antena GPS terpasang di luar, cek apakah
antena tersebut sudah tersambung dengan baik. Antena yang
longgar akan menghasilkan pembacaan sinyal yang buruk. Antena
tambahan dapat digunakan setelah sambungan kabel dengan GPS
terkoneksi dengan baik. Bersihkan sambungan kabel (connector)
dan terminal dari kotoran atau cairan karena akan berpengaruh
terhadap kemampuan alat menangkap sinyal.

GPS akan tetap berfungsi dengan baik walaupun terbungkus
dalam plastik sehingga memudahkan penentuan posisi di
lingkungan dengan kelembaban tinggi atau hujan. Pastikan bahwa
penutup plastik tersebut tertutup rapat dan diikat pada bagian
bawah GPS, bukan bagian atas karena akan memberi peluang
masuknya rembesan air ke bagian dalam. lkat kantong plastik
dengan karet yang kuat. Pilih kantong plastik yang tidak terlalu
tebal atau tipis untuk memudahkan kita melakukan tekanan pada
tombol-tombol di bagian permukaan GPS. Secara berkala cek
plastik pembungkus, segera ganti bila plastik tersebut berlubang.

o Kamera dijital

Kamera dijital menjadi pilihan, karena banyak kelebihannya
dibanding kamera konvensional, antara lain: hasil pemotretan
dapat langsung dilihat hasilnya, dapat menampung foto lebih
banyak sesuai dengan kapasitas kartu memorinya,dan lain-lain.
Yang paling penting, adalah hasil pemotretan dapat langsung
dimasukkan ke dalam format data base, tanpa melalui proses
pencetakan di studio foto.
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Selain kartu memori yang mempunyai kapasitas cukup (> 1 Gb),
jangan sampai tertinggal kelengkapan battery charger, bila perlu
membawa baterai cadangan.

e Kompas

Berfungsi untuk mengetahui orientasi arah sesuatu obyek
terhadap arah utara. Pada GPS-pun telah ada kompas, dan bisa
dimanfaatkan untuk mengetahui arah.

X 3
o

Gambar 7. Berbagai model kompas.

Kompas juga dapat menjadi alat pendukung bagi GPS jika lokasi
yang didatangi tidak dapat menerima sinyal satelit GPS (lokasi
yang tertutup) dikarenakan cara kerja kompas yang menggunakan
gaya magnet bumi untuk menunjukkan arah. Penggunaan kompas
menjadi sangat penting apabila surveior bermaksud memetakan
gua-gua peninggalan peperangan yang ada di bawah tanah.

e Roll meter
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Diperlukan untuk mengukur satuan panjang atau luasan suatu
obyek. Sebaiknya memakai roll meter yang berupa pita yang dapat
digulung.

Gambar 8. Berbagai ukuran roll meter.

Kombinasi antara kompas dan roll meter dapat menjadi pengganti
GPS dalam memetakan obyek-obyek sejarah di tempat tertutup.

e Alat tulis dan gambar

Diperlukan untuk mengisi formulir lapangan tentang obyek
sejarah yang akan didata, dan pembuatan sketsa obyek. Alat ini
meliputi : pensil 2B, ballpoint, blocknote, mistar 30 cm, clipboard,
dan lain-lain yang diperlukan saat survei.
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Gambar 7. Contoh sketsa situs purbakala

Sketsa tentang lokasi diperlukan untuk memperkirakan bentuk asli
dari obyek sejarah karena hasil dari foto tidak selalu dapat
menunjukkan bentuk aslinya akibat dari rusaknya obyek atau ada
bagian yang berubah bentuk. Sketsa juga bermanfaat dalam
mendapatkan data melalui proses pemetaan partisipatif untuk
melihat batasan nilai budaya yang ada di suatu wilayah.

e Alatrekam

Apabila diperlukan wawancara dengan nara sumber untuk
menggali informasi suatu peristiwa sejarah ataupun keterangan
mengenai obyek sejarah, tetapi kita tidak bisa mencatat pada saat
itu (di lapangan). Hasil rekaman harus ditulis ulang dan disarikan
sesuai kebutuhan untuk pengisian basis data.
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Gambar 8. Contoh alat perekam dijital

e Komputer jinjing

Merupakan alat utama di dalam proses pembuatan peta. Alat ini
mengolah data dijital baik yang berupa teks, spreadsheet, citra
(foto, gambar, video), serta keruangan (SIG). Tanpa komputer
seluruh kegiatan pembuatan peta dijital tidak mungkin dapat
dilakukan.

Pengolahan data peta di lapangan secara langsung setelah survei
memberikan kemampuan bagi surveior untuk melakukan evaluasi
terhadap survei yang telah dilakukan sehingga dapat dilakukan
perbaikan dihari berikutnya.

e Petadasar

Peta analog atau peta konvensional atau hardcopy merupakan
sumber (bekal) utama dalam survei lapangan. Berdasarkan peta
dasar inilah perencanaan survei lapangan dilakukan.
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Gambar 12. Peta Rupa Bumi indonesia dan Citra satelit SPOT-5
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3.2,

Peta dasar yang digunakan adalah Peta Rupabumi Indonesia (Peta
RBI) yang diterbitkan oleh Badan Informasi Geospasial (BIG),
dengan skala 1:25.000 untuk wilayah Pulau Jawa dan 1:50.000
untuk wilayah di luar Pulau Jawa. Peta dasar dengan skala
1:10.000 juga tersedia untuk beberapa kota.

Selain penggunaan peta dasar dari BIG, surveior juga dapat
menyiapkan peta citra atau foto udara untuk daerah yang akan
dipetakan melalui mekanisme yang telah diatur dalam INPRES No.
6 Tahun 2012 tentang Penyediaan, Penggunaan, Pengendalian
Kualitas, Pengolahan dn Distibusi Data Satelit Penginderaan Jauh
Resolusi Tinggi.

Pengumpulan Data

Pengumpulan data sejarah atau sumber sejarah dan nilai budaya dapat

dilakukan pada tahap persiapan dan pelaksanaan (pemetaan). Yang

membedakan proses pengumpulan data tahap persiapan dilakukan

dengan mengumpulkan data yang bisa diperoleh di perpustakaan, arsip,

wawancara, hal ini bertujuan untuk mengidentifikasi lokasi yang akan di
petakan. Sedangkan pada tahap pelaksanaan, data atau sumber yang
diperoleh langsung di lokasi.

Hakikat data sejarah dan nilai budaya dapat dikelompokkan menjadi:

1) Data tertulis terdiri dari:

Berita kontemporer (surat kabar, majalah)
Penerbitan resmi pemerintah

Kenangan pribadi tokoh lokal (otobiografi, memorie)
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e Arsip (kantor pemerintah, milik swasta/perusahaan, proses verbal
polisi, pengadilan dsb).

e Prasasti.
2) Data Lisan:
Data lisan terdiri dari sejarah lisan, ingatan kolektif dan tradisi lisan.

e Sejarah lisan atau “oral history” yaitu sebuah teknik pengumpulan
data sejarah dan nilai budaya yang dilakukan oleh seorang
pewawancara kepada yang memiliki informasi (informan)
kemudian direkam dan dijadikan bahan penulisan sejarah atau
informasi nilai budaya di suatu wilayah. Misalnya: (1) peristiwa
sejarah yang tidak terdokumentasikan dengan baik atau si pelaku
tidak membuat catatan tertulis, seperti dalam perjuangan
kemerdekaan banya hal yang disampaikan secara lisan melalui
telik sandi agar tidak diketahui musuhnya. Hali ini untuk
penggalian sejarah lisan menjadi sangat penting; (2) pengetahuan
seseorang mengenai sejarah budaya atau tradisi lokal yang
berlaku di wilayahnya dapat membantu dalam proses pemetaan
hingga sejauh mana tradisi tersebut berlaku.

e Memori Kolektif adalah konsep psikologi yang berarti
pengetahuan yang tersimpan dalam pikiran orang. Dengan
memori seseorang dapat mempresentasikan pengalaman dan
pengetahuan tentang masa lalunya. Jadi memori sejarah (menurut
Mestika Zed, 2004) adalah pikiran-pikiran yang secara eksplisit
mengacu pada peritiwa-peristiwa masa lalu dan pengalaman-
pengalaman apakah itu nyata atau imajinasi. Contoh: peristiwa G-
30S/PKI yang telah menjadi memori kolektif bahwa tanggal 30
September telah terjadi kudeta oleh PKI. Memori kolektif bisa
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berasal dari pengalaman individual, tetapi bisa juga diperoleh dari
bacaan.

e Tradisi Lisan:

Setiap masyarakat memiliki tradisi yang hidup (living tradition)
yang dihayati dan dilaksanakan dari satu generasi ke generasi
selanjutnya. Tradisi itu berupa pola yang menjadi kesepakatan
bersama di masa lalu yang berlanjut hingga masa kini. Bentuknya
adalah:

a) Ungkapan tradisional, yaitu ungkapan-ungkapan dari masa
lalu yang sampai kini masih digunakan oleh masyarakat
pendukungnya.

b) Sajak dan puisi rakyat seperti : parikan, saloka, geguritan, dan
pantun.

c) Cerita prosa rakyat seperti Ande-ande lumut, Joko Tarub dll

d) Pertanyaan tradisional masyarakat seperti cangkriman di
Jawa.

e) Nyanyian rakyat
3) Artefak

Artefak merupakan sumber sejarah dalam bentuk benda-benda yang
dihasilkan dan digunakan oleh pelaku sejarah di masa lampau.
Seperti gerabah, keris, sabit, mandau, rencong, uang logam, mesin
ketik tua, dan bangunan misalnya benteng, makam, batu nisan,
menara radio, masjid, gereja, dan sebagainya.
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4) Audio Visual

Audio visual adalah informasi yang telah tersimpan di dalam media
dalam bentuk suara dan/atau gambar. Misalnya: lukisan, sketsa, foto,

mikrofis, mikrofilm, video, film, compact disc, website dan
sebagainya.

5) Lokasi
Lokasi adalah satuan ruang tempat terjadinya peristiwa sejarah.
Misalnya: bekas-bekas pemukiman

3.2.1. Sumber Data Sejarah dan Nilai Budaya

Data sejarah dan nilai budaya dapat dikategorikan menurut berbagai cara,
antara lain menurut sifat dan bentuknya. Dilihat dari sifatnya dikenal
sumber primer dan sumber sekunder. Sementara dilihat dari bentuknya

dikenal sumber kebendaan, sumber tertulis dan sumber lisan.

Tabel 3. Karakteristik sumber data sejarah dan nilal budaya

SEJARAH NILAI BUDAYA
Sumber Data Primer/Utama: Sumber Data Primer/Utama:
Sumber primer dapat berupa dokumen | Sumber  primer  dapat  berupa

dan artefak. Sumber primer dapat
dilacak melalui lembaga arsip, pelaku
sejarah dan situs sejarah. Selain itu
sejalan dengan perkembangan
teknologi dapat pula dilacak melalui
internet

Metode pemindaian (scanning) peta-
peta lama/kuno sering digunakan untuk
rekontruksi kawasan, analisa temporal
perubahan geomorfologi, dan lain lain

wawancara mendalam, observasi di
lapangan, dan kuesioner.

Metode observasi dengan tinggal
bersama dalam kurun waktu tertentu
dan ikut berpartisipasi dalam sebuah
komunitas dapat memberikan
gambaran mengenai perilaku budaya

komunitas tersebut.
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apabila dilakukan perbandingan dengan
data-data saat ini.

Sumber Data Sekunder/Tambahan:
Sumber data sekunder dapat diperoleh
dengan  saksi
sejarah yang memiliki kredibilitas atau
tingkat kepercayaan tinggi.

melalui wawancara

Sumber Data Sekunder/Tambahan:
Sumber data sekunder dapat diperoleh
buku, dokumentasi,
catatan mengenai kebudayaan.

melalui atau

+ A

e

Couardspont “Husjtenwacht” v
» - -

A L'

Lars oot »

i

1.4 Batavia and Surroundings, 1740 (Reproduced from Adolf Heuken, Historical
Sites of Jakarta, Jakarta, Cipta Loka Caraka. 1982)

Gambar 93. Contoh sumber data peta kuno yang teiah dipindai

44

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA




3.2.2. Data Lapangan
Pengumpulan data primer kegiatan pemetaan sejarah dan nilai budaya
meliputi:

a) Penentuan wilayah survei

Informasi tentang wilayah yang akan dipetakan sangat penting,
karena hal ini akan berkaitan dengan kelancaran proses
pengumpulan data di lapangan. Berdasarkan hasil pengumpulan data
literatur/pustaka yang telah dilaksanakan sebelumnya, wilayah survei
dapat ditentukan.

b) Pengumpulan data sejarah dan nilai budaya

Instrumen formulir lapangan merupakan panduan bagi surveior
sejarah dan nilai budaya dalam rangka mengumpulkan informasi
mengenai obyek sejarah yang diobservasi dan wujud kebudayaan
yang diamati. Unsur-unsur yang ada dalam formulir lapangan ini
diharapkan sudah dapat mewakili keterangan lengkap mengenai
obyek dari sudut pandang sejarah dan nilai budaya (Lampiran 1).

c) Penentuan posisi obyek dengan GPS

Data koordinat yang diperoleh dengan instrumen GPS juga dapat
diatur mengenai parameter datum dan sistem proyeksi yang
digunakannya, sehingga dapat disesuaikan dengan data dasar spasial
lainnya yang akan dioperasikan dalam SIG. Pada kegiatan survei
pemetaan sejarah dan nilai budaya ini, tipe GPS yang akan digunakan
adalah GPS Handheld Navigasi dengan akurasi 5—20 m (Lampiran 2).
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Sumber: Garmin web-page

Gambar 10. Konstelasi orbit satelit GPS

d) Formulir (borang) dan kelengkapan data lapangan

Bagian ini merupakan rangkaian dari instrumen formulir yang
digunakan pada saat survei lapangan. Formulir yang dimaksud adalah
pengambilan gambar melalui kamera fotografi terhadap obyek target
maupun kondisi lingkungan sekitar obyek target. Data lapangan lain
yang perlu dilakukan adalah penggambaran sketsa keruangan obyek
target.

Sehingga, sampai dengan tahap ini minimal ada 4 data terpisah yang
harus dilakukan pengelolaan datanya dengan baik, yaitu;

1. Data formulir lapangan,

2. Data koordinat obyek (tersimpan dalam memori GPS dan
tercatat dalam formulir lapangan),
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3. Foto obyek (tampak depan) dan foto kondisi sekitar obyek (no
foto tercatat dalam formulir lapangan dan pada memori
kamera dijital),

4. Sketsa/denah lokasi (digambar pada kertas terpisah) untuk
kemudian dilakukan perekaman dengan kamera dijital atau
scanning dan konversi ke format grafis dijital.

3.3. Pengolahan Data

3.3.1, Pengisian Basis Data

Format basis data obyek sejarah dan nilai budaya yang merupakan data
atribut dari SIG sejarah dan nilai budaya yang dibangun dalam pedoman
ini menggunakan format Microsoft Access dengan desain yang informatif.
Informasi yang terkandung dalam basis data tersebut dirinci mulai dari ID
obyek, Kode obyek, keterangan lokasi, atribut obyek sejarah, tanggal
pendataan, pencatat, serta lokasi koordinat titik obyek sejarah dan nilai
budaya yang berisi informasi koordinat baik itu sistem UTM (Universal
Transverse Mercator) maupun dalam sistem Lintang Bujur (Geographic).
Basis data tersebut juga ditunjang dengan foto obyek dan lingkungan
obyek.

Pengisian basis data berdasarkan formulir yang diisi ketika petugas
pengumpul data berada di lapangan, sedang untuk keterangan obyeknya
diisi berdasarkan hasil informasi yang didapat dari buku dan laporan-
laporan. Setelah melakukan entry data pada form basis data yang telah
disusun dengan menggunakan Microsoft Access, basis data tersebut dapat
dihubungkan dengan data spasial melalui data koordinat pada setiap
obyek sejarah yang terdata, dengan teknologi ArcGlIS.

47

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



3.3.2. Integrasi Data

Pembuatan pedoman ini merupakan sistem penanganan data sejarah
yang berbasiskan peta dijital dan bereferensi geografis. Pembuatan peta
obyek-obyek sejarah terdiri pemasukan data (input) dan pengolahan data.
Dalam integrasi data dalam pedoman ini dimaksudkan adalah
penggabungan antara basis data sebagai data utama dan peta dijital
bereferensi geografis sebagai informasi spasial tentang obyek-obyek
sejarah untuk diolah menjadi suatu keluaran spasial baru atau tematik
berisi tentang keletakan obyek-obyek sejarah yang telah di plotting.

Integrasi data yang dilakukan adalah koneksi data melalui Object Linking
and Embedding, Basis data (OLE-DB) yang memungkinkan mengakses data
dari berbagai sumber dengan cara yang seragam. Dengan menggunakan
OLE-DB yang langsung dapat koneksi ke dalam program ArcGIS, maka data
atribut yang tersimpan dalam basis data Microsoft Access (*.accdb) dapat
diakses dan digabungkan dengan data spasial yang telah diambil
sebelumnya.

Dengan ArcGIS, basis data obyek-obyek sejarah dan nilai budaya dapat
divisualkan, di-explore, dianalisis secara geografis untuk pengambilan
suatu keputusan ataupun perencanaan untuk memproteksi  dan
pengelolaan obyek-obyek sejarah.

3.3.3. Pemetaan Berbasis 5IG

Pada tahap pemetaan berbasis SIG, peta dasar yang digunakan sebagai
acuan sesuai amanat UU No. 4 tahun 2011 adalah Peta Rupa Bumi
Indonesia yang diterbitkan oleh BIG. Selain peta dasar analog yang
digunakan pada saat survei lapangan, peta dasar yang berformat dijital
juga diperlukan pada saat proses penggambaran data hasil survei ke
bidang peta.
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Sistem proyeksi peta dan sistem koordinat/grid yang digunakan dalam
pemetaan sejarah dan nilai budaya skala besar (1:5000 sampai 1:100.000)
adalah sistem proyeksi dan koordinat Universal Transverse Mercator
(UTM), sedangkan untuk peta skala kecil (lebih dari 1:100.000)
menggunakan sistem proyeksi dan sistem koordinat geografis dangan
datum WGS 1984.

Langkah penggambaran data hasil survei lapangan ke bidang peta secara
dijital ke dalam perangkat lunak SIG disebut juga dengan proses dijitasi
atau vektorisasi. Dijitasi merupakan proses perolehan elemen
gambar/layer baik berupa: titik, garis, maupun poligon dari sebuah media
data grafis baik dalam format dijital maupun analog dengan cara
melakukan deliniasi ulang pada obyek tersebut dengan menggunakan
meja digitizer atau digitasi langsung pada layar monitor komputer.

Metode ini sering kali digunakan dalam SIG untuk perolehan data
tambahan yang diperlukan untuk analisa spasial maupun hanya sekedar
untuk pengkayaan informasi data dari sebuah kegiatan.

Obyek sejarah dan nilai budaya dapat disajikan ke dalam peta dalam tiga
jenis simbol, yaitu: titik, garis dan area (poligon):

e Obyek peristiwa sejarah, diwujudkan dalam simbol titik dan garis,
misal tempat terjadinya sejarah (Gedung Perjanjian Linggarjati di
Kuningan, Jawa Barat) sebagai simbol titik, sedangkan simbol garis
untuk menunjukkan gerakan suatu peristiwa sejarah, misal rute
gerilya Panglima Besar Jenderal Sudirman yang berpindah-pindah
dari satu tempat ke tempat lain sebagai simbol titik untuk lokasi-
lokasi perhentiannya, dan simbol garis untuk menunjukkan gerak
berpindahnya dari satu lokasi ke lokasi lainnya. Penentuan posisi
dengan GPS dilakukan pada satu titik yang mewakilinya.
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Gambar 114, Rute gerilya Panglima Besar Jenderal Soedirman disimboikan dengan garis

e Obyek wilayah dan bangunan bersejarah, diwujudkan dalam
simbol area (poligon). Bangunan bersejarah tidak berdiri secara
tunggal, tetapi selalu terkait dengan lingkungannya — mempunyai
batas-batas wilayah - simbolnya berupa area (poligon).
Penentuan posisi dengan GPS dilakukan tidak hanya pada
bangunannya saja, tetapi juga pada batas-batas terluar dari
bangunan tersebut. Hal yang perlu diingat adalah peta dasar yang
dipakai adalah Peta RBI yang mempunyai skala 1:25.000, yang
berarti 1 mm di peta mempunyai nilai 25 m di lapangan. Ini berarti
obyek terkecil yang dapat dipetakan adalah yang mempunyai
radius 25 m, obyek-obyek yang jaraknya satu dengan lainnya lebih
kecil dari 25 m di lapangan, di dalam peta masih berupa satu titik.
Oleh karena itu, penentuan posisi dengan GPS dilakukan apabila
diperkirakan setelah ada perbedaan jarak > 25 m antara satu titik
dengan titik lainnya. Penentuan posisi untuk obyek wilayah dan
bangunan bersejarah dilakukan pada titik-titik batas terluar
wilayah (area), selain pada titik/lokasi bangunannya sendiri.
Jumlah titik penentuan posisi tergantung pada bentuk wilayahnya,
teratur atau tidak teratur. Bentuk wilayah yang teratur, titik-titik
penentuan posisi lebih sedikit dibandingkan wilayah yang tidak
teratur.
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Contoh : penentuan posisi GPS pada bentuk wilayah seperti di
bawah ini, dilakukan pada 7 titik, dengan titik Z sebagai titik obyek
bangunan, dan titik A — F sebagai titik terluar batas wilayah obyek

Gambar 125, Contoh penentuan area bangunan bersejarah menggunakan GPS

Metode penggunaan dan sistem operasi dengan GPS ini ada pada
bagian lampiran 3.

e Obyek wujud kebudayaan berupa bangunan fisik disimbolkan
menggunakan simbol titik. Bangunan fisik dalam artian wujud
kebudayaan dianggap berdiri sendiri karena setiap bangunan fisik
memiliki informasi atribut sendiri yang terdiri dari: fungsi, gaya
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arsitektur, status bangunan, peran masa lalu, dan daya tahan

terhadap perubahan tradisi/budaya baru.

Tabel 4, Simbol atribut budaya

ATRIBUT BUDAYA

Fungsi

Agama

Wisata

Ekonomi

Pemerintahan

Arsitektur

Lokal

Cina

Timur Tengah

Eropa

Status

Cagar Budaya

Milik Swasta

Bangunan Publik

Sejarah/Peranan
Masa Lalu

Ada

Tidak Ada

Belum Diketahui

Daya Tahan

Tinggi

Sedang

v = ]lO|P IPDPDIW|IN|=

Rendah

-
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Wilayah komersil

Gambar 136. Contoh penggambaran/simbolisasi obyek wujud kebudayaan bangunan
fisik,

e Obyek tradisi lokal yang berupa jalur disimbolkan menggunakan
simbol garis yang menunjukkan jalur perjalanan. Misalnya jalur
perayaan panen padi digambarkan dengan garis perjalanan dari
sumber pertanian (sawah) menuju tujuan akhirnya di lumbung
padi.
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Gambar 147, Contoh penggambaran/simbolisasi wujud kebudayaan tradisi lokal

e Obyek tradisi lokal yang berupa nilai budaya disimbolkan
menggunakan simbol area yang menunjukkan perbedaan nilai
budaya yang ada di tiap-tiap wilayah dalam sebuah batas
administrasi dusun, desa, ataupun kecamatan. Misalnya nilai
budaya mengenai orientasi kehidupan yang ditinjau dari mata
pencaharian penduduknya  dengan mempertimbangkan
pemahaman tentang cara memandang alam, pemanfaatan
teknologi, tuntutan/kebutuhan, cara hidup (berorganisasi,
bersosialisasi, dsb). Data yang dibutuhkan antara lain adalah peta
batas administrasi sesuai dengan unit pemetaan, dan data
kependudukan (monografi desa, statistik wilayah, dan
sebagainya).
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o Contoh : Kabupaten X terdiri dari 9 kecamatan

:

Mata Pencaharien Ketergantungan pada alam

WS Petani sawoh non irigasi et
o ani sawoh non irigasi -me
Petani sawah irigasi - Sedong
Petani lodang
Perdagangon

' Pegowai

| Rendoh

Buruh industri

‘Waktu sokral {bo’da
Maghrib)
- ‘Waktu profon [Pkl 18.30}

Gambar 18. Contch penggambaran/simbolisasi nilai budaya untuk melihat orientasi
kehidupan.

3.4. Penyajian Data
Dalam basis data obyek sejarah dan nilai budaya, data lokasional disajikan
sebagai simbol-simbol sesuai dengan karakteristik obyek tersebut.

Agar obyek-obyek sejarah dan nilai budaya ini dapat dengan mudah
digunakan, maka tampilan layar yang disajikan haruslah mudah
dimengerti. Kemudahan untuk menggunakan program sangatlah
diperlukan, karena siapapun yang menggunakan dapat mengerti apa yang
harus dilakukan.

Penyajian detail obyek-obyek sejarah merupakan hal penting yang
menyangkut teknik dan seni menyampaikan informasi, selain itu, tentu
saja harus memperhatikan akurasinya. Sajian detail yang banyak tidak
selalu berkonotasi baik, karena peta akan nampak terlalu padat dan tidak
informatif. Peta sejarah dan nilai budaya yang berbasis peta dijital,
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pengelolaan informasinya ini dapat dikelola lebih baik karena setiap
kelompok informasi dapat disimpan pada layer berbeda dan secara instan
dapat diatur informasi mana yang harus ditampilkan dan mana yang harus
disembunyikan.

a) Pembuatan peta dan atlas dijital

Peta dan atlas sejarah akan menampilkan informasi mengenai suatu
peristiwa, sebab akibat, lokasi serta tokoh-tokoh yang terlibat. Peta
dan atlas tersebut disusun berdasarkan layer layer tematik yang telah
dibuat menggunakan prosedur dan tata cara seperti di atas.
Perangkat lunak SIG sangat memungkinkan dalam pembuatan peta
dan atlas sejarah ini karena kemampuan dalam menyimpan,
memperbaharui, mengelola, mengintegrasi, menganalisa serta
menampilkan data kembali. Tema-tema sejarah akan banyak sekali
yang ditampilkan menggunakan kemampuan analisa dan
menampilkan peta dalam berbagai tema serta dalam kurun waktu
yang berbeda. Dengan atlas dan peta dijital pengguna dapat lebih
interaktif dalam memanggil kembali serta mendapatkan informasi
baru dengan queri dari data atributnya dan bahkan membuat peta
baru dari analisa ataupun overlay peta atau layer-layer yang telah
ada.

Sistem Informasi Geografis memiliki fasilitas untuk pembuatan peta
atau atlas dijital. Fasilitas ini hampir tersedia pada seluruh perangkat
lunak SIG yang bersifat komersiil. Perkembangan teknologi perangkat
lunak SIG saat ini bahkan memungkinkan untuk melakukan suatu
produksi peta (map production). Produksi peta yang dimaksud adalah
suatu teknik pemetaan otomatis dalam skala basis data yang besar.
Artinya bahwa, fasilitas SIG memungkinkan melakukan otomatisasi
pembuatan cetak peta dalam jumlah tak terbatas (sesuai dengan
volume basis data yang digunakan). Fasilitas ini, selain beberapa
komponen dasar kartografi standard yang terpenuhi, komponen
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pewarnaan peta pada beberapa perangkat lunak SIG sudah
menggunakan aplikasi sistem pewarnaan untuk industri percetakan.

Acuan dasar pembuatan peta/atlas dijital untuk aplikasi pemetaan
sejarah disajikan dalam bagian tersendiri dalam pedoman ini
(Lampiran 4 dan 5)

b) Pembuatan peta dan atlas analog

Meskipun teknologi pemetaan sudah masuk pada fase pemetaan
dijital, bukan berarti instrumen peta/atlas analog tidak dibutuhkan
lagi. Pengguna SIG (khususnya di Indonesia) masih pada lapisan
terbatas, bahkan dapat dikatakan minor, tetapi pengguna peta/atlas
analog di Indonesia terdiri dari seluruh lapisan masyarakat, mulai dari
siswa sekolah dasar, akademisi, perencana, dan pengambil keputusan
masih selalu menggunakan peta/atlas analog dalam membaca
wilayah. Hal ini disebabkan karena tidak seluruh lapisan masyarakat
sudah memahami (familier) SIG, hanya beberapa pengguna saja
(kelompok teknisi) yang selalu melakukan eksplorasi terhadap sistem
informasi ini.

Seperti telah dijelaskan pada sub bab sebelumnya, tahapan akhir dari
SIG pada umumnya adalah penyajian data spasial dalam bentuk
sebuah peta yang dapat digunakan oleh para pengguna melalui
pencetakan peta. Kemampuan SIG dalam penyajian peta adalah
terpenuhinya unsur-unsur standard pemetaan yang benar. Faktor
inilah yang juga membedakan SIG dengan perangkat lunak pengolah
gambar lainnya, yang tidak memperhitungkan aspek geometri suatu
elemen gambar.

Acuan dasar pembuatan peta/atlas analog untuk aplikasi pemetaan
sejarah dan nilai budaya disajikan dalam bagian tersendiri dalam
pedoman ini.
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Gambar 19. Desain layout peta sejarah dan nilai budaya

Keterangan:

1)  Judul peta 6) Legenda (keterangan peta)
2) Orientasi peta 7) Petunjuk lokasi peta

3) Indeks peta 8) Sumber data dan peta

4)  Skala numerik 9) Pembuat Peta

5) Skala grafis 10) Tahun Produksi Peta

c) Publikasi multimedia

Publikasi multimedia yang dimaksud adalah suatu produk dalam
format dijital yang dapat diakses dan dijalankan pada suatu media
komputer dengan menggunakan suatu perangkat lunak yang mudah
dan secara bebas dapat diperoleh dipasaran secara cuma-cuma.
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Produk perangkat lunak semacam ini disebut dengan produk ‘open
source’.

Keluaran dari publikasi multimedia biasanya dikemas dalam suatu
kepingan CD (compact disc) yang dapat berisi dokumen mengenai
pemetaan sejarah berkaitan dengan laporan kegiatan maupun hasil
dari aplikasi-aplikasi lain yang ada di dalamnya baik itu berupa
basisdata yang dikompilasi maupun aplikasi geospasial yang
dihasilkan.

59

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



BAB 4. SARANA DAN PRASARANA

4.1. Perangkat Keras
Terdiri dari perangkat keras yang digunakan untuk pengumpulan data
lapangan dan pengolahan data.

1. Perangkat keras untuk pengumpulan data lapangan terdiri dari :

GPS (Global Positioning System)

Alat ini berfungsi untuk menentukan posisi suatu objek di permukaan
bumi, dengan memanfaatkan sinyal yang ditangkap dari satelit. Posisi
objek di permukaan bumi dinyatakan dengan koordinat yang
mengacu pada sistem koordinat tertentu.

Pada dasarnya GPS terdiri atas tiga segmen yaitu : segmen angkasa,
kontrol/pengendali, dan pengguna, ketiga segmen tersebut
mempunyai fungsi masing - masing diantaranya :

1) Segmen angkasa: terdiri dari 24 satelit yang berfungsi untuk
mengirimkan posisi dan waktu kepada pengguna di seluruh
dunia.

2) Segmen Kontrol/Pengendali: pusat pengendali utama yang
terdapat di Colorodo Springs, dan 5 stasiun pemantau lainnya
dan 3 antena yang tersebar di bumi ini.

3) Segmen Pengguna: Pada sisi pengguna dibutuhkan receiver
GPS (perangkat GPS) untuk dapat menerima signal satelit GPS
dan kemudian menghitung posisi, kecepatan dan waktu.

Untuk dapat menggunakan GPS sebagaimana fungsinya setidaknya
GPS harus memliki 3 signal satelit untuk menghitung posisi 2D dan
dibutuhkan 4 atau lebih signal satelit untuk menghitung posisi 3D
position (longituge, latitude, dan altitude (ketinggian). Dengan
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informasi posisi, GPS dapat menghitung data lain seperti : receptacle,
arah, lintasan, jarak tempubh, jarak tempuh, jarak ke tujuan, matahari
terbit & terbenam dan lain-lain

Kamera digital

Digunakan untuk merekam objek yang akan dipetakan, dan disajikan
dalam basis data. Sesuai dengan perkembangan teknologi informasi,
tidak disarankan untuk memakai kamera konvensional, agar
mempercepat dan mempermudah dalam memasukkannya ke dalam
basis data yang telah dirancang.

Alat komunikasi (HT, telepon genggam)

Digunakan untuk komunikasi dalam satu tim pengukuran posisi.

2. Perangkat keras untuk pengolahan data terdiri dari :

Komputer (PC/laptop)

Merupakan alat utama dalam pengolahan data sehingga akan
dihasilkan peta yang diinginkan. Komputer ini akan mengolah data,
baik yang berupa teks, spreadsheet, citra (foto, gambar, video), serta
keruangan (GIS). Oleh karena itu diperlukan komputer dengan
spesifikasi yang memadai, agar pengolahan data tersebut di atas
dapat berjalan dengan lancar.

Printer

Hasil pengolahan data akan disajikan ke dalam peta melalui printer
untuk ukuran yang tidak terlalu besar (hingga A3). Untuk kepentingan
itu diperlukan printer berwarna, yang mempunyai kecepatan
pencetakan tinggi.
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Plotter

Selain peta dicetak dengan menggunakan printer, untuk peta ukuran
besar diperlukan plotter berwarna.

Scanner

Alat ini digunakan untuk mengkonversi gambar/citra/ image analog
menjadi data digital. Hal ini diperlukan apabila kita tidak bisa
mengambil objek secara langsung di lapangan, sehingga diperlukan
sumber data sekunder lain.

4.2. Perangkat Lunak
Perangkat lunak yang digunakan dalam seluruh rangkaian kegiatan, semua
berbasis Windows, meliputi :

1) ArcGIS 10 atau yang lebih baru (Perangkat lunak SIG berbasis
vektor)

ArcGlIS 10 desktop terdiri atas 4 (empat) aplikasi dasar yakni :

a) ArcMap : Arcmap merupakan aplikasi utama yang
digunakan dalam ArcGIS yang digunakan untuk mengolah
(membuat (create), menampilkan (viewing), memilih
(query), editing, composing dan publishing) peta.

b) ArcCatalog : ArcCatalog adalah aplikasi yang berfungsi
untuk mengatur/mengorganisasi berbagai macam data
spasial yang digunakan dalam pekerjaan SIG. Fungsi ini
meliputi tool untuk menjelajah (browsing), mengatur
(organizing), membagi (distribution) dan menyimpan
(documentaion) data-data SIG.
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c) ArcGlobe : aplikasi ini berfungsi untuk menampilkan peta-
peta secara 3D ke dalam bola dunia dan dapat
dihubungkan langsung dengan internet.

d) ArcScene : ArcScene merupakan aplikasi yang digunakan
untuk mengolah dan menampilkan peta-peta ke dalam
bentuk 3D

e) Selain itu adalah kumpulan Tools yang tersedia di dalam
setiap Komponen ArcGIS namanya AcrToolbox.
ArcToolBox terdiri dari kumpulan aplikasi yang berfungsi

2) ArcGIS 10 3D dan Spatial Analyst extension untuk analisa spasial
data DEM (digital elevetaion model)

3) Garmin Map Source/Basecamp (Perangkat lunak pengolah data
GPS dari vendor Garmin) atau Easy GPS (Perangkat lunak open
source pengolah data GPS)

4) Microsoft Access (Perangkat lunak pengolah data base non-
spasial)

Microsoft Access adalah suatu program aplikasi basis data
komputer relasional yang digunakan untuk merancang, membuat
dan mengolah berbagai jenis data dengan kapasitas yang besar.
Aplikasi ini menggunakan mesin basis data Microsoft Jet Basis
data Engine, dan juga menggunakan tampilan grafis yang intuitif
sehingga memudahkan pengguna. Versi terakhir adalah Microsoft
Office Access 2007 yang termasuk ke dalam Microsoft Office
System 2007.

5) Microsoft Excel (Perangkat lunak pengolah data base non-spasial)

6) Adobe Photoshop (Perangkat lunak pengolah data grafis)
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Adobe Photoshop, atau biasa disebut Photoshop, adalah
perangkat lunak editor citra buatan Adobe Systems yang
dikhususkan untuk pengeditan foto/gambar dan pembuatan efek.

Atau perangkat lunak yang lain sesuai dengan perkembangan teknologi
SIG.
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BAB 5. PELAPORAN

Tahap terakhir dari sebuah kegiatan adalah pelaporan. Pelaporan dalam
kegiatan pemetaan sejarah ada tiga bentuk yaitu:

e Tertulis,
e (D,

e Petatercetak

5.1. Laporan tertulis

Dalam laporan ini akan memberikan gambaran proses perolehan data,
pengolahannya dan kendala-kendala yang dihadapi, baik saat
pengumpulan data maupun dalam proses pengolahannya, hingga
dihasilkan peta tematis sejarah dan nilai budaya. Dengan kata lain laporan
tertulis dapat dikelompokan menjadi dua bagian, yaitu :

A. Laporan Survei Lapang, terdiri dari:
a) Latar Belakang
b) Maksud dan Tujuan
¢) Cara Pengambilan Data

Pengambilan data dapat dilakukan dengan mengunjungi
lokasi yang akan dipetakan serta menghubungi
individu/instansi/ lembaga yang berkaitan dengan tema
penelitian sejarah yang dilakukan.

d) Deskripsi lokasi yang Disurvei

e) Keberadaan dan Bentuk Data
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f)

g)

h)

i)

Data-data yang digunakan dapat berupa denah lokasi,
peta lokasi survei, dan laporan lain yang mencakup tema
dari penelitian Sejarah yang sedang dilaksanakan.

Alternatif Cara Memperoleh Data

Cara pencarian data yang dibutuhkan bisa dilihat pada
peta indeks yang memperlihatkan lokasi peta per grid
dengan nomor peta yang sudah ditentukan. Data atau
Peta tersebut bisa diperoleh dengan cara membeli atau
fotokopi dengan harga terlampir.

Kesulitan dan Kemudahan Mendapatkan Data
Hasil Diskusi

Kesimpulan

B. Laporan Hasil, terdiri dari :

a)
b)
c)
d)
e)
f)
g)
h)
i)

Daftar isi

Daftar Tabel

Daftar Gambar/ Peta

Daftar Lampiran

Pendahuluan

Tinjauan Pustaka

Materi dan Metode Pelaksanaannya
Hasil dan Pembahasan

Kesimpulan dan Saran
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5.2. Laporan dalam CD

Selain dalam bentuk tertulis, hasil dari kegiatan pemeteaan sejarah dan
nilai budaya dapat disajikan dalam bentuk CD. Dalam CD ini terkandung
berbagai informasi tentang hasil pemetaan di lapangan, serta berbagai
data atribut dan data keruangan yang menjadi dasar dalam penyusunan
peta sejarah dan nilai budaya, juga peta hasil akhir dari kegiatan, peta
yang ada di dalamnya dapat dicetak ulang sesuai kebutuhan pengguna.
Peta yang ada bersifat interaktif, karena selain menunjukkan posisi/letak
objek sejarah dan nilai budaya, juga dapat dilihat data base dari objek
tersebut. Laporan dalam CD ini akan dapat dimanfaatkan untuk bahan ajar
bagi mata pelajaran sejarah.

5.3. Laporan dalam bentuk Peta Tercetak

Peta merupakan hasil akhir yang penting dalam sebuah kegiatan
pemetaan. Peta tercetak (hard copy) ini menyajikan letak suatu objek
sejarah, tidak memperlihatkan data base (data atribut/keterangan) dari
objek tersebut.
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Lampiran 1a

FORMULIR BASIS DATASEJARAH
SURVEY INVENTARISASI PRODUK

SEJARAH
DI INDONESIA
A. INFORMASI SPASIAL
1 Kode
| P
2 Nama Obyek
A T TN Y I A A AN I A I I I A
3 ID Lokasi
O S ) O I A A 7
Prov. Kab./Kota Kec. Desa/Kel.  Dukuh
4 Jalan
(T T T T T Y TN W Y O A O A
e g 4 T 0 5 F 0 % §.9 fd i g 3 4
5 Koordinat !
GeOgraﬁS Lintang S [0 S W [N N | O -
Bujur Ll JL L L L1 ||
6 Koordinat UTM
VR I N Y Y
V2 T T O Y

7 Keterangan Lain

8 Keterangan Foto
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Lampiran 1a

B. INFORMASI BANGUNAN FISIK

1 || Kategori Peristiwa — Peristiwa J Benda
—  Manusia
2 || Periode —  Hindu-Budha [l Revolusi
o Jepang Kemerdekaan
O Islam ] OrdeBaru
] Kolonial [0 Pergerakan
[  Reformasi
3 | Sumber Peristiwa [J  Pemerintah 1 Tokoh
[0 Individu Masyarakat/Komunit
as
~  Rumah Tangga

(g]

SKETSA
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Lampiran 1a

D. INFORMASI PENDATAAN

1 | Nama

N Y I T A I YT N Y N A I A O O A
Pendata
2 | Tanggal TN T T T N YT T Y N Y O A O A O
Pendataan
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Lampiran 1b

FORMULIR BASIS DATA NILAI BUDAYA
SURVEY INVENTARISASI NILAI BUDAYA
DI INDONESIA

A. INFORMASI SPASIAL

1 | Kode

2 | Nama
Obyek

Y A N [ O O O N OO O N A O 1 O /Y |

3 | ID Lokasi
O G Vs O S [ O O G

Prov. Kab./Kota Kec. Desa/Kel.  Dukuh

4 | Koordinat

Geografis N O S o Y

e ) = B T

Lintang
Bujur

5 | Koordinat
UTM

L.
-

< X

6 | Keterangan
Lain

7 | Keterangan
Foto
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Lampiran 1b

B. INFORMASI BANGUNAN FISIK
1 | Fungsi Bangunan ~ Agama —  Wisata
—  Ekonomi —  Pemerintahan
2 | Gaya Arsitektur —  Lokal O Timur Tengah
1 China ~ Eropa
3 || Status —  Cagar Budaya —  Bangunan Publik
—  Milik Swasta
4 | Daya Tahan — Tinggi 7 Rendah
Bangunan —  Sedang
5 | Sejarah/Peran 7 Ada [0 Belum Diketahui
Masa Lalu  Tidak Ada
6 | Periode _ Hindu - Budha — Revolusi Kemerdekaan
_ Jepang — Orde Baru
~ Islam _ Pergerakan
_ Kolonial _ Reformasi
7 | Sumber Informasi 7l Pemerintah ” Tokoh Masyarakat/Komunitas
— Individu —  Rumah Tangga
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Lampiran 1b

INFORMASI TRADISI LOKAL

Lokasi _ Tetap = Khusus
— Berubah-Ubah [ Tidak Khusus
Pelaku/Ketokohan — Tokoh Lokal — Rumah Tangga
&Pemerintah — Komunitas/Tokoh Lokal
— Individu
Jalur — Tetap C Khusus
_ Berubah-Ubah ~ Tidak Khusus

Relasi Bangunan
Situs

1 Satu Kompleks

|

Berdiri Sendiri/Terpisah

Situasi/Kondisi _ Ramai & Akses ~ Ramai & Akses Mudah
Sekitar Sulit _ Tidak Ramai & Akses Mudah
~ Tidak Ramai &
Akses Sulit
Daya Tahan ] Tinggi (Belum ~ Rendah (Termodifikasi Sebagai
Tradisi Termodifikasi) Besar)
_ Sedang
(Termodifikasi
Sebagian Kecil)
Teritorial ~ Wilayah Adat Wilayah Hutan

71 Wilayah Komersil

[

Wilayah Pertanian

INFORMASI ORIEN

TASI KEHIDUPAN

Mata Pencaharian

—  Petani Sawah
Irigasi

— Petani Sawah
Non Irigasi

Z PetaniLadang

[T O O

Pegawai
Buruh Industri
Perdagangan
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Lampiran 1b

2 | Ketergantungan _ Tinggi [0 Rendah
Pada Alam _] Sedang
3 | Konsep Waktu —  Sakral
—  Waktu Profan
E. SKETSA
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Lampiran 1b

F. INFORMASI PENDATAAN
1 Nama Pendata Ll g
2 Tanggal Pendataan T N O ) 0 O O OO O O 0 o O 0 A L O

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 1c

PETUNJUK PEMBUATAN DAN PENGISIAN BASIS
DATA SEJARAH & NILAI BUDAYA
MENGGUNAKAN MS. ACCESS

1. Pendahuluan

Microsoft Access adalah salah satu program diantara

program-program keluaran Microsoft. Microsoft Access

digunakan sebagai program pengolah data yang dikenal juga

dengan istilah data base Access. Program ini bertujuan

menyediakan fasilitas untuk penyimpanan data (bank data)

dari berbagai format seperti: tulisan, foto digital dan video

yang bisa dikolaborasikan ke berbagai program lain. Berikut

uraian singkat pembuatan data base Access.

1. Klik start a All Program pilih Microsoft Access,

2. Selanjutnya pilih Blank Database pada layer New File,

3. Beri nama File yang akan dibuat, dan pilih folder mana
dokumen tersebut akan disimpan

4. Setelah itu klik Create, otomatis anda telah membuka file
dengan nama baru pilihan anda,

5. Langkah selanjutnya adalah pembuatan Table.

Untuk lebih jelas langkahnya dapat dilihat pada gambar

berikut ini:
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Lampiran 1c

i Mirouft Glfis Beodt 2570
AN secrmmoty Offim S 2007
A5 ol Seu RO T
§ o OfFice Sontinte 2N
i Phorosskt Sftes kook 200
8 ool Ot B G007
435 wmcrolt Sffen M S0
Moot ol o 2
& Phvostft e toos

i dorepades

i POT Paerd ey A0

| Getting Storsed with Micros

Blank Database

Cragke s Microsolt Office Avcess databaye that doss
it conkales Ay edieting dete or objects,

File Names

[Patabaset accdb

CAUsersiSatratlocmente

Sebagai informasi, dalam pembuatan sebuah data base, yang
harus dipersiapkan adalah apa tujuan kita membuat data
base, data apa yang dibutuhkan atau data apa yang akan
dikumpulkan dalam bentuk item-item, sesuai dengan tema
yang kita ambil. Misalnya data base sejarah, tema-tema yang
dibutuhkan adalah:

a. Nomor urut Obyek sejarah,

b. Nama Obyek Sejarah,

c. Alamat (Jalan) Obyek Sejarah,

d. Kategori Obyek Sejarah dan seterusnya. (lihat gambar
berikut):

6. Setelah itu pilih Create Table in Design view, anda akan
dibawa ke tahap pengisian Field seperti contoh di atas, (lihat
gambar berikut):
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Lampiran 1c

Isi nama Field sesuai kebutuhan, kemudian Pilih Type data
(Jenisdata), yang biasa digunakan adalah:

a.
b.

LT

Text, jika yang diisikan berapa tex

Memo, jika data yang akan diisikan berupa keterangan
mengenai obyek. Karena dalam database sejarah, sering
ditemukan data yang ingin dimasukkan namun tidak
tersedia Fieldnya. Untuk itu di kolom keteranganlah
dituangkan data tersebut.

Number, jika datanya berupa numeric/nomor saja,
Date/Time, jika data yang akan dimasukkan berupa
keterangan waktu (dalam format waktu standar) seperti
tanggal-bulan-dan tahun,

Auto Number, pilihan nomor otomatis,

Yes/No, penggunaan isian Ya atau Tidak,

OLE Obyek, yaitu kolom tempat memasukkan foto digital
dalam field,

Hyperlink, jika bahan vyang dimasukkan ingin
disambungkan dengan data lain,
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Lampiran 1c

1. Lookup Wizard, digunakan untuk mengisi data isian
dalam bentuk pilihan. Misalnya Kategori sejarah ada tiga
pilihan, Alam, Manusia dan Benda. Isian ini biasa juga
dikenal dengan nama combo box.

Berikut cara pembuatan Combo Box :
a. Pilih field yang akan diberikan pilihan (jawaban),
b. Klik pada lookup wizard,
c. Setelah kotaknya tampil, pilih I will type in the values
that | want,
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| Semarang
iakarta
Surabaya
logjakarta
Banten
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Lampiran 1c

7. Save data dengan nama yang dinginkan.Kembali ke

Menu awal, pilih Forms.

x:mﬁ‘
B ot
L e

Datmrbieat Vigw
PhogdTstde View

2. Membuat Form

Dalam Microsoft Access, form digunakan untuk memudahkan

pengguna dalam melakukan pengolahan data, seperti

penyisipan (insert), pengubahan atau pembaharuan (update),

dan penghapusan (delete) data. Sama dengan tabel dan

query, terdapat 2 cara berikut untuk membuat form:

a. Create form in Design view: Cara membuat form yang

sesuai dengan keinginan, vyaitu dilakukan dengan

memasang beberapa komponen yang diinginkan secara

manual yang sesuai dengan kebutuhan. Cara ini relatif

rumit dan memerlukan banyak proses.

b. Create form by using wizard: Cara ini memungkinkan

membuat form dengan cepat karena ini hanya dilakukan
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Lampiran 1c

dengan pemilihan nama tabel yang akan diolah dan
dilanjutkan dengan memilih field-field mana saja yang

perlu ditampilkan pada form.

2.1. Membuat Form Dengan Form Wizard
Langkah-langkah yang dilakukan dalam cara ini adalah

sebagai berikut:
1. Klik create.
2. Pilih form Wizard.

Datasheet

8] Table2

Modal Dialog

FivotTable

Emdey

Pada tampilan, hasilnya muncul seperti di bawah irii:

3. Pilih table/queries yang akan dibuat form.
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Lampiran 1c

Whidh el do yous want on your form?

| You an thoose fom mors than one tabie or query,

4. Pilih field yang akan dimasukkan ke dalam form,

kemudian pilih next.

Which fields do you want on your form?

“You can choase from more than one tablle of query,
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Lampiran 1c

m;Wwi&mmth
f!! i

5. Tulis judul form yang akan dibuat.
6. Pilih modify the form’s design untuk memodifikasi
tampilan form.

7. Klik finish.

IO RY Ay gu— -

muumummumm
Do you mant i open e form o modfy the forls desgn?

5 pen e form to view oc enter infermation.
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Lampiran 1c

8. Buat design sesuai dengan keinginan.

Nama CEjet
3

90
It atitot
It tehaanDess

IE CukuhDusin
Forgingirtns
Koordio 8-
FoordingUTMX
KoordinstUTMY
Keterangan L3
Feterangan Foto
Fungsi Bangunan
Ganasteits

status

D Tahar Basiuran
o SenaPerin Mass b3y
Fescce
Sumbe[rfcrmas.
el Besgunars Lo
Feputetoraan

e e

E“MWV"WWWMMM::} Seppar et

ariggs,

Susrmer i

ks

ekt

Ko e B S Relas: Bangunin

omgesani Biga Tovin Rt i . D Tahan Tadisl

Kooz aTH &

Konsep iy,

g,
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Lampiran 1c

PETUNJUK PENGISIAN DATABASE SEJARAH &
NILAI BUDAYA MENGGUNAKAN SOFTWARE
MS. ACCESS

1. Pendahuluan

Pada bagian ini akan dijelaskan mengenai bagaimana cara
mengisi database yang sudah dikumpulkan dari lapangan
kemudian diinput ke dalam data tabular yang mudah
dimengerti dan mudah diinput. Sebelumnya tadi telah
membuat desain formulir menggunakan Ms. Access, maka
pada petunjuk pengisiannyapun masih menggunakan
software ini.

Langkah-langkah untuk melakukan pengisiannya sebagai
berikut :
1. Masuk ke dokumen yang telah dibuat sebelumnya

S

==Y
¥ %

2. Identifikasi & Cara Pengisian
1) ID = Nomor yang menunjukkan urutan & posisi entri
data. Nomor ini bertambah secara otomatis
2) Kode -> Berisi nomor atau tanda yang
mereferensikan sesuatu di lapangan. Misalnya
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Bangunan Kuno diwakili dengan nomor 1, Candi
diwakili 2, dll

3) Nama Objek > berisi tentang nama/atau peristiwa
yang terjadi di suatu lokasi yang disurvey.

4) ID Provinsi = diisi berdasarkan ID Provinsi yang
dikeluarkan oleh BPS/DEPDAGRI

5) ID Kab/Kota -> diisi berdasarkan ID Kabupaten yang
dikeluarkan oleh BPS/DEPDAGRI

6) D Kelurahan/Desa -> diisi berdasarkan ID Kabupaten
yang dikeluarkan oleh BPS/DEPDAGRI

7) 1D Dukuh/Dusun -> diisi berdasarkan ID Kabupaten
yang dikeluarkan oleh BPS/DEPDAGRI

8) Koordinat Lintang —> diisi sesuai dengan posisi
koordinat lintang lokasi yang diplot menggunakan
GPS. Jika pengaturan pada GPSnya menggunakan
sistem koordinat geografis

9) Koordinat Bujur > diisi sesuai dengan posisi
koordinat bujur lokasi yang diplot menggunakan GPS.
Jika pengaturan pada GPSnya menggunakan sistem
koordinat geografis

10) Koordinat UTM X -> diisi sesuai dengan posisi
koordinat X lokasi yang diplot menggunakan GPS. Jika
pengaturan pada GPSnya menggunakan sistem
koordinat Universal Transverse Mercator (UTM)

11) Koordinat UTM Y - diisi sesuai dengan posisi
koordinat Y lokasi yang diplot menggunakan GPS. Jika
pengaturan pada GPSnya menggunakan sistem
koordinat Universal Transverse Mercator (UTM)

12) Keterangan Lain - Diisi jika terdapat informasi
penting yang harus dicantumkan pada saat
pelaporan

13) Keterangan Foto - diisi jika memiliki foto yang dapat
dicantumkan pada saat pelaporan

14) Fungsi Bangunan - diisi dengan pilihan isian, yaitu :
Agama, Ekonomi, Wisata, dan Pemerintahan
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15) Gaya Arsitektur = diisi dengan pilihan isian, yaitu :
Lokal, China, Timur Tengah, Eropa

16) Status > diisi dengan pilihan isian, yaitu : Cagar
Budaya, Milik Swasta, Bangunan Publik

17) Daya Tahan Bangunan -> diisi dengan pilihan isian,
yaitu : Tinggi, Sedang, Rendah

18) Sejarah/Peran Masa Lalu = diisi dengan pilihan isian,
yaitu : Ada, Tidak Ada, dan Belum Diketahui

19) Periode > Diisi dengan pilihan isian, yaitu : Hindu-
Budha, Jepang, Islam, Kolonial, Revolusi
Kemerdekaan, Orde Baru, Pergerakan, dan
Reformasi.

20) Sumber Informasi > diisi dengan pilihan isian, yaitu :
Pemerintah, Individu, Tokoh Masyarakat/Komunitas,
dan Rumah Tangga

21) Lokasi = diisi dengan pilihan isian, yaitu : Tetap,
Berubah-Ubah, Khusus, Tidak Khusus

22) Pelaku/Ketokohan —> diisi dengan pilihan isian, yaitu
: Tokoh Lokal & Pemerintah, Individu, Rumah Tangga,
Komunitas/Tokoh

23) Jalur > diisi dengn pilihan isian, yaitu Tetap,
Berubah-ubah, Khusus, dan Tidak Khusus

24) Relasi Bangunan -> diisi dengan pilihan isian, yaitu
Satu Kompleks, Berdiri Sendiri/Terpisah

25) Situasi = diisi dengan pilihan isian, yaitu : Ramai &
Akses Sulit, Tidak Ramai & Akses Sulit, Ramai & Akses
Mudah, dan Tidak Ramai & Akses Mudah

26) Daya Tahan -> diisi dengan pilihan isian, yaitu :
Tinggi, Sedang, dan Rendah

27) Teritorial = diisi dengan pilihan isian, yaitu : Wilayah
Adat, Wilayah Komersil, Wilayah Hutan, dan Wilayah
Pertanian

28) Mata Pencaharian = diisi dengan pilihan isian, yaitu :
Petani Sawah irigasi, Petani Sawah Non irigasi, Petani
Ladang, Pegawai, Buruh Industri, dan Perdagangan
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29) Ketergantungan Alam -> diisi dengan pilihan isian,
yaitu : Tinggi, Sedang, dan Rendah

30) Konsep Waktu > diisi dengan pilihan isian, yaitu :
Sakral, dan Waktu Profan

31) Sketsa -> diisi dengan file gambar atau foto

32) Nama Pendata - diisi dengan nama pendatanya

33) Tanggal Pendataan —>diisi dengan tanggal saatsurvey
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PETUNJUK PENGGUNAAN GPS
(GPS 60 CSX)

GPS adalah sistem navigasi dan penentuan posisi
menggunakan satelit yang dikembangkan dandikelola oleh
Departemen Pertahanan Amerika Serikat. GPS dapat
memberikan informasi tentang posisi, kecepatan dan waktu
di mana saja di muka bumi setiap saat, dengan ketelitian
penentuanposisi dalam fraksi milimeter sampai dengan
meter. Kemampuan jangkauannya mencakup seluruh dunia
dan dapat digunakan banyak orang setiap saat pada waktu
yang sama (Abidin,H.Z, 1995).

Prinsip dasar penentuan posisi dengan GPS adalah
perpotongan ke belakang dengan pengukuran jarak secara
simultan ke beberapa satelit GPS seperti gambar berikut :

/kw"’ ey d4-
/ (XA’ YA’ ZF\) ‘\
(‘67;'«1 Aas h)
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5.1. Sistem GPS

Untuk dapat melaksanakan prinsip penentuan posisi di atas,
GPS dikelola dalam suatu sistem GPS yang terdiri dari dari 3
bagian utama yaitu bagian angkasa, bagian pengontrol dan
bagian pemakai, seperti gambar berikut :

SATELIT

.21+ 3 satetit

. periode orbit : 12 jam

. altitude orbit : 20200 km

PENGGUNA

. Mengamati sinyal GPS

. Hitung posisi dan kecepatan
. Dapatkan informasi
mengenai waktu

SISTEM KONTROL
. Sinkronisasi waktu

. Prediksi orbit

. Injeksi data

. Monitor kesehatan satelit

5.1.1. Bagian Angkasa

Terdiri dari satelit-satelit GPS yang mengorbit mengelilingi
bumi, jumlah satelit GPS adalah 24 buah. Satelit GPS
mengorbit mengelilingi bumi dalam 6 bidang orbit dengan
tinggi rata-rata setiap satelit £ 20.200 Km dari permukaan
bumi.
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Pengiriman
i i i salah saty dari
i Stats Ground Centrol Station

» Master Control Station

Pemrosesan dato
. Pengontrolon Satelit
. Pengoperasian sistem

Konstelasi Satelit di Luar Angkasa

Setiap satelit GPS secara kontinyu memancarkan sinyal-sinyal
gelombang pada 2 frekuensi L-band (dinamakan L1 dan L2).
Dengan mengamati sinyal-sinyal dari satelit dalam jumlah
dan waktu yang cukup, kemudian data yang diterima
tersebut dapat dihitung untuk mendapatkan informasi posisi,
kecepatan maupun waktu.

5.1.2. Bagian Pengontrol

Adalah stasiun-stasiun pemonitor dan pengontrol satelit yang
berfungsi untuk memonitor dan mengontrol kelaikgunaan
satelit-satelit GPS. Stasiun kontrol ini tersebar di seluruh
dunia, yaitu di pulau Ascension, Diego Garcia, Kwajalein,
Hawai dan Colorado Springs. Di samping memonitor dan
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mengontrol  fungsi  seluruh satelit, juga berfungsi
menentukan orbit dari seluruh satelit GPS.

5.1.3. Bagian Pengguna

Adalah peralatan (Receiver GPS) yang dipakai pengguna
satelit GPS, baik di darat, laut, udara maupun di angkasa. Alat
penerima sinyal GPS (Receiver GPS) diperlukan untuk
menerima dan memproses sinyal-sinyal dari satelit GPS untuk
digunakan dalam penentuan posisi, kecepatan, maupun
waktu.

Secara umum Receiver GPS dapat diklasifikasikan sebagai
berikut :

1. Receiver militer

2. Receiver tipe navigasi

3. Receiver tipe geodetic
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5.2. Metoda-Metoda Penentuan Posisi dengan GPS

Pada dasarnya konsep dasar penentuan posisi dengan satelit
GPS adalah pengikatan ke belakang dengan jarak, yaitu
mengukur jarak ke beberapa satelit GPS yang koordinatnya
telah diketahui.

Perhatikan gambar berikut :

Penentuan posisi dengan GPS dapat dikelompokkan atas
beberapa metoda diantaranya :

e Metoda absolut,
e Metoda relatif (differensial).
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5.2.1. Metoda Absolut

Penentuan posisi dengan GPS metode absolut adalah
penentuan posisi yang hanya menggunakan 1 alat receiver
GPS. Karakteristik penentuan posisi dengan cara absolut ini
adalah sebagai berikut :

1. Posisi ditentukan dalam sistem WGS 84 (terhadap
pusat bumi).

2. Prinsip penentuan posisi adalah perpotongan ke
belakang dengan jarak ke beberapa satelit sekaligus.

3. Hanya memerlukan satu receiver GPS.
Titik yang ditentukan posisinya bisa diam (statik) atau
bergerak (kinematik).

5. Ketelitian posisi berkisar antara 5 sampai dengan 10
meter.

Aplikasi utama untuk keperluan navigasi, metoda penentuan
posisi absolut ini umumnya menggunakan data pseudorange
dan metoda ini tidak dimaksudkan untuk aplikasi-aplikasi
yang menuntut ketelitian posisi yang tinggi.

5.2.2. Metoda Relatif (Differensial)

Yang dimaksud dengan penentuan posisi relatif atau metoda
differensial adalah menentukan posisi suatu titik relatif
terhadap titik lain yang telah diketahui koordinatnya,

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 2a

pengukuran dilakukan secara bersamaan pada dua titik
dalam selang waktu tertentu. Selanjutnya dari data hasil
pengamatan diproses/dihitung akan didapat perbedaan
koordinat kartesian 3 dimensi (dx, dy, dz) atau disebut juga
dengan baseline antar titik yang diukur.

Karakteristik umum dari metoda penentuan posisi ini adalah
sebagai berikut :

1. Memerlukan minimal 2 receiver, satu ditempatkan
pada titik yang telah diketahui koordinatnya.

2. Posisi titik ditentukan relatif terhadap titik yang
diketahui.

3. Konsep dasar adalah differencing process dapat
mengeliminir  atau  mereduksi  pengaruh  dari
beberapa kesalahan dan bias.

Bisa menggunakan data pseudorange atau fase.

5. Ketelitian posisi yang diperoleh bervariasi dari tingkat
mm sampai dengan dm.

6. Aplikasi utama : survei pemetaan, survei penegasan
batas, survei geodesi dan navigasi dengan ketelitian

tinggi.

5.2.3. Ketelitian Penentuan Posisi dengan GPS

Penentuan posisi dengan GPS dipengaruhi oleh faktor-faktor
sebagai berikut :
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1. Ketelitian data terkait dengan tipe data yang
digunakan, kualitas receiver GPS, level dari kesalahan
dan bias.

2. Geometri satelit, terkait dengan jumlah satelit yang
diamati, lokasi dan distribusi satelit dan lama
pengamatan.

3. Metoda penentuan posisi, terkait dengan metoda
penentuan posisi GPS yang digunakan, apakah
absolut, relatif, DGPS, RTK dan lain-lain.

4. Strategi pemrosesan data, terkait dengan real-time
atau post processing, strategi eliminasi dan
pengkoreksian kesalahan dan bias, pemrosesan
baseline dan perataan jaringan serta kontrol kualitas.
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5.3. Penggunaan GPS GARMIN 60CSX

.~ Power|/
lampu
Zoom ,Zoom
inpeta # Suipina
v \\
\\
- \ o Halaman GP$
Waypoint //
’I
Mark Menu Utama GPS
Waypoint
Keluar dari Mengeksekusi
menu pilihan

5.3.1. Tombol pada GPS

Tombol Power : menghidupkan dan mematikan GPS
menghidupkan dan mematikan lampu layar.

Tombol Page : Digunakan untuk memilih halaman.
Mengatur tampilan kontras pada satelite page

Tombol Enter : Konfirmasi masukan data atau memilih
menu .Menampilkan menu pada halaman utama
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Tombol Menu : Membuka menu utama GPS. Mengatur
satuan unit yang digunakan dalam GPS

Tombol Quit : Keluar dari MenuKembali ke halaman
sebelumnya

Tombol Mark : Menandai sebuah lokasi sebagai Waypoint

Tombol Find  : Mencari Waypoint yang sudah dibuat

Tombol Zoom in dan Zoom Out: memperbesar dan
memperkecil tampilan dari peta

Cursor : mengarahkan kursor pada layar GPS

5.3.3. Halaman Pada GPS

Semua informasi yang dibutuhkan untuk mengoperasikan
GPS dapat ditemukan dalam lima halaman utama (layar
tampilan). Halaman-halaman ini antara lain satelit, peta,
pointer, dan menu. Ketika dinyalakan tekan tombol PAGE
untuk memilih halaman-halaman tersebut.

Halaman Informasi Penerimaan Satelit:

Informasi mengenai satelit yang tersedia, kekuatan sinyal
masing-masing satelit, tingkat akurasi pengukuran lokasi
dalam satuan meter.
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Halaman Peta:

Gambaran lokasi suatu obyek terhadap obyek lain di atas
permukaan bumi. Menunjukkan arah perjalanan dan
kecepatan perjalanan.
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Halaman Kompas/Arah mata angin:
Informasi mengenai bearing (arah) & jarak ke waypoint
tujuan, kompas berjalan, kecepatan bergerak ke waypoint

tujuan.

?isf‘m =N
AL
[Time To Nea

|01:4T:

Halaman Informasi Ketinggian:
Informasi mengenai ketinggian dari permukaan laut, tekanan

udara, kecepatan jelajah secara vertikal.
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Halaman Menu Utama:

Informasi mengenai manajemen waypoint, setup (sistem,
navigasi, &interface), dan rute perjalanan., games, kalkulator,
kalender dll.

"Moin Menu

Halaman Perjalanan:
Menampilkan Informasi perjalanan yang ditempuh oleh GPS
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5.3.4. Menentukan Waypoint dan Tracking

Waypoint adalah lokasi dimana anda dapat menandai
(menyimpan dalam memori) sebagai arah untuk navigasi
nantinya.

Pada Posisi tempat Kita Berada
1. Tekan dan tahan tombol ENTER untuk menampilkan
display MARK WAYPOINT pada 60 CSx tekan tombol
MARK

2. Untuk menyimpan titik yang ditentukan arahkan
kursor pada tombol OK dan tekan enter. Bila ingin
merubah informasi, arahkan kursor pada bagian yang
diinginkan tekan enter dan pilih huruf atau angka yang
diinginkan
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5.3.5. Fasilitas GOTO

GPS dapat membantu anda menuju titik (waypoint) yang

sudah ditentukan sebelumnya dengan menggunakan fasilitas
GOTO (GOTO = GOing TO).

Mencari dan menentukan arah dari tempat GPS berada:

1
2

Tekan tombol FIND untuk menampilkan FIND MENU
Pilih kategori ikon ( Waypoint, cities, exits, dll ) Pilih
Waypoint dan Enter

Pada Waypoint list, pilih titik yang diinginkan dan
tekan Enter

Menu ini dapat pula di akses dari tombol FIND, tekan
tombol Find untuk membuka menu FIND kemudian
pilih waypoint seperti langkah 2.

Pada menu Waypoint pilih Go To dengan
menggunakan kursor dan tekan enter  untuk

memulai Navigasi.
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Setelah anda memilih GOTO, GPS akan memandu anda ke
tujuan dengan menggunakan halaman pointer (pointer
page). Pointer (panah) akan menunjukkan anda arah ke
waypoint tujuan anda. Jalan ke arah yang ditunjukkan panah
hingga panah menunjuk ke arah atas dari kompas. Jika panah
menunjuk ke arah kanan, berarti anda harus berjalan ke
kanan. Jika panah menunjuk kea rah kiri, pergilah ke kiri. Jika
panah telah menunjuk tepat ke atas pada kompas, berarti
anda telah berada pada jalur yang benar.

CATATAN PENTING

Informasi tambahan : lihat website GARMIN untuk
mengetahui keterangan terbaru dan detail tentang
pengoperasian dan asesorisnya
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EASY GPS
(Petunjuk Menggunakan Easy GPS)

1. Pendahuluan

Easy GPS merupakan salah satu perangkat lunak yang
berlisensi open source/gratis untuk mendukung semua
produk-produk alat GPS dari berbagai merk diantaranya
Garmin, Lowrance, Magellan, MLR, Bruton dan lain-lain. Easy
GPS dapat diunduh di alamat
http://www.easygps.com/download.asp. Tampilannya
sebagai berikut :

{11 www wasygns.com ik s
by {7 basie ) ifor@is| 7 Doiind T3 S (1) Bk 303l The Lowoe | Kagkus 1| T

gEasyGPs

BGet the world's #1 free GPS software.., .

s.com/do

&
&
-
=
2
»
B Mcid T T
0o
o
100% FREE softwes , ads, & ars Linkmted topn PrIna serial shotost
Downioad geacaches 0 NaYPOIA 16 Your G¥5 Combine GPS, CAD, ond 75 dats
Backip and prnt out your POl and tracks View your GFS caty in Google Eenth

Hoc, Tt
Tk GRS resaivery,

i
GARMIN MAGELLAN-, LOWRANCE

iy st

Sorre, EavGFE s 00k Supportad on Windaws F&, Windows 2699, Maciotesh, Mac 08X, or Linuk,

Easy GPS dapat dengan cepat mengunduh, mengunggah, dan
mengedit data dari dan ke GPS.
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Tampilan antarmuka (User Interface) dari Easy GPS sangat
sederhana dan mudah dimengerti sesuai dengan namanya
“Easy” yang berarti mudah untuk digunakan. Easy GPS ini
tidak memerlukan spesifikasi computer yang terlalu tinggi.
Namun perangkat lunak ini tidak dapat di install pada OS
(Operation System) seperti Linux, Macintosh, Windows 98,
Mac 0OSX, dan Windows 2000.

2. Instalasi Easy GPS ke Komputer

Proses instalasi software ini tidak memerlukan waktu yang
lama dan filenya pun tidak besar sehingga mudah untuk di
distribusikan antara satu komputer ke komputer lain.
Langkah-langkah proses instalasinya dijelaskan sebagai
berikut :

a. Arahkan ke folder penyimpanan master software easy
GPS, yaitu SetupEasyGPS.exe

P software

Favorites

. Downloads

RecentPlaces
BE Desktop

i Libraries

§§3 Computer
£ Local Disk (C:)
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b. Maka akan muncul jendela instalasi sebagai berikut.

Setup - EasyGPS

Welcome to the EasyGPS Setup
Wizard
This will install EasyGPS 4.93.0.0 on your computet,

It is recommended that vou close all other applications befare
continuing,

Click Next to continue, or Cancel to exit Setup,

1! Setup - EasyGPS

Select Destination Location
Where should EasyGPS be installed?

c. Tunggu proses instalasi hingga komplit. Klik Finish dan
software siap untuk dijalankan.
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Installing
Please wait while Setup installs EasyGPS on your computer,

Setup - EasytiPs . > : .

Completing the EasyGPS Setup
Wizard

Setup has finished installing EasyGPS on your computer, The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

¥ Launch EasyGPS
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3. Tampilan Antarmuka (User Interface) Easy GPS

1. Menu Pulldown stardar

Berfungsi untuk membuat dokumen baru

Berfungsi untuk membuka dokumen yang telah
disimpan sebelumnya

Berfungsi untuk menyimpan lembar kerja ke
dalam format *.gpx

Berfungsi untuk melihat peta, titik plotingan, dan
profil ketinggian sebelum di cetak
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s A . W
Berfungsi untuk menambahkan waypoint berupa

;’ {.;Tﬂr: | koordinat beserta informasinya
A | Berfungsi untuk mencari waypoint dan
Fird geocaches

@g Berfungsi untuk mengunggah atau mengirimkan
S;w g data berupa waypoint, routes, tracks ke GPS

H i Berfungsi untuk mengunduh atau menerima data
= berupa waypoint, routes, tracks dari GPS

Receive
m Berfungsi untuk menggeser tampilan peta yang
MLl s terdapat pada lembar kerja
® Berfu.ngsi untuk memperbesar 'skala atau
Zoom tampilan peta pada lembar kerja
N Berfungsi untuk menyeleksi fitur yang ada di
Aol lembar kerja (waypoint, routes, tracks )
\ Berfungsi untuk membuat rute berdasarkan
Boute waypoint yang ada di lembar kerja

5. Fungsi Menu Pulldown
Pada menu ini secara umum fngsinya hampir sama dengan
menu yang biasa digunakan oleh perangkat lunak lainnya.
Namun, menu yang terdapat di software easy GPS ini sedikit
diringkas sehingga mudah untuk diingat. Beberapa menu
diantaranya sebagai berikut:

[Fle Edt Find Took GPS Window Help|

.Penjelasan menu

yang terdapat di menu utama akan dijelaskan di bawah ini.
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a. File Menu->berisi tentang fitur-fitur umum seperti
pembuatan dokumen, penyimpanan hingga pencetakan

New Ctel+N
Open,.. Ct+C
Merge Files... Ctrie
Close Ctrle W
Save Ctri«5
Save Aso.

File Informatian...

Print.. Ctelap
Print Preview
Print Setup,..

Lgeocaching loc

Exit Ctri+Q
b. Edit Menu->berisi tentang fitur-fitur untuk menyeleksi,
mengedit dan menghapus data dan mengatur preferensi
lembar kerja.

Unde Cti+Z
Cut Cerle X
Copy Ciel-C
Paste ChrisV
Select All Ctrle A
Find... e+ F
Show All

Edit Enter
Delete Del

Preferences..  CirlsShift+P

c. Geocache Menu > berisi tentang fitur-fitur untuk
melihat, mencari geocaches,

Yiew Geocache Web Page
Log Your Geocache Find!

Decrypt Hint

View Online
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d. Tools Menu =>berisi tentang fitur-fitur penambahan

waypoint baru, foto, dan fitur navigasi pada lembar kerja.

Mew Waypoint... F2

Add Phictos...

Set Active Point

Yiew Online F5

Yiew in Photo Viewer
v Move Mep I
&, Zoom Zz
Ny Select 5
N Route R

e. GPS Menu > berisi tentang fitur-fitur yang berhubungan
dengan mengunduh dan mengunggah file dari GPS

Send Selected to GPS..
Send to GPS..

Receive from GPS..

Display GPS Information...

f. Help Menu > berisi tentang fitur-fitur bantuan
mengoperasikan software dan melihat tipe/seri software

yangsedang digunakan.

EasyGPS Help

About EasyGPS...

Visit EasyGPS Forums..,

Special Offers
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6. Mengatur Preferensi Lembar Kerja

2. Klik Edit = Preferences

1. Maka akan muncul kotak isian
pengaturan Unit, Tipe GPS,
Geocaching dan Koordinat.

3. Unit of Measure
- untuk

mengatur unit
atau satuan ukur

dalam lembar
kerja
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World Geodetic System 1984

© Sant Pierre and Mauslon

7. Mentransfer Data Dari GPS ke Komputer

Pada bagian ini merupakan langkah bagaimana agar data GPS
dapat disimpan dan dapat dibuka hasilnya pada lain waktu.
Langkahnya sebagai berikut :

a. Hubungkan GPS dengan menggunakan kabel data yang
disediakan oleh provider ketika awal beli.

b. Jalankan program Easy GPS yang telah di instal di
komputer
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Adobe Captivate 4 P 1. Klik Start > Easy GPS
g8 Adobe Captivate Reviewer 1.0 i et

3 Adobe Device Central C53
s Adobe Extndscript Toolkit 2
{8 Adobe Photoshiop €54
&3, Advanced JPEG Compressor
4 Default Programs

G Desktop Gadget Gallery

3

18 Intek® AT Service signup
&8 Internet Explorer (64-bit)
&8 1rtemet Explorer
@ Mozl Firefox

Wi ABBYY FineReader 11
Al Accessories

Adobe Help YViewer 2
& Advanced SystemCare 6

Maka akan tampil jendela

easy GPS seperti ini

Shee sl S
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c. Klik Ikon ﬂmve atau Receive From GPS

3 tosys - [Ukiedz)

Add GPS

3. Pilih merek
GPSnya

Trete e o wagonts ‘o il

2. Pilih Seri
GPSnya

e
il e - -
d. lJika berhasil, maka akan muncul tampilan sebagai berikut

2. Pilih USB

1.Kiik OK

L
e. Setelah itu akan muncul kotak dialog. Data apa saja yang

ingin diunduh dari GPS. Dengan menceklis maka berarti
data itu yang akan diunduh.
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Rceie fro GPS
1. Ceklis data yang akan
diunduh

2. Klik OK

f. Jika berhasil, maka data akan tampil pada lembar kerja
seperti di bawah ini

Hasil Unduhan Data
Dari GPS

Data yang di ceklis
sebelumnya akan tampil
dalam bentuk daftar

File = Save.
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< Save atau tkon

8. Mengedit & Menambahkan Titik/ Waypoint

a. Untuk mengedit waypoint yang telah di unduh dari GPS
caranya adalah sebagai berikut

1. Arahkan ke titik yang akan di
edit. Kemudian Klik Kiri hingga
terseleksi berwarna kuning
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3. Klik kanan pada titik yang akan
disdit -> Pilih Feit Wawnaint

merubah Type

Edit untuk mer 1 nama/iabel p

Edit untuk menambahkan

S.Edit untuk merubah 2 di GPS

8 Edit un

it untuk mervbah bol pada lembar kerja
—
Weitag, B
W G

&.Edit untuk merubah
elevasi & satuannya

5, Edit untuk
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b. Untuk menambahkan waypoint langkahnya sebagai
berikut

ald

Waypoint. Atau ikon B3

9. Membuat Rute Berdasarkan Waypoint

Membuat rute merupakan salah satu langkah dalam
merencanakan perjalanan atau navigasi menuju titik yang
dikehendaki namun melalui titik-titik yang sudah
direncanakan sebelumnya. Hal ini dapat menghemat waktu
dan biaya. Hal yang harus diperhatikan dalam merencanakan
rute adalah memiliki titik-titik atau plotingan yang akan
dilewati. Langkah-langkah mengoperasikan mengedit dan
menambahkan rute adalah sebagai berikut:

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 2b

N\
a. Klik Route atau ikon Fede untuk membuat rute baru

rencana rutenva

Akhiri rute dengan

kiri dua kali
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Maka jika berhasil, akan tampil rute yang telah dibuat pada
lembar kerja seperti berikut ini

10. Mentransfer Data dari Komputer ke GPS

Pada bagian ini software Easy GPS dapat mentransfer data
baik berupa Waypoint, Tracks, Routes maupun Geocaches
dari computer ke GPS. Langkah-langkahnya sebagai berikut:

a. Dengan menambahkan dan mengedit data dari software
ini yang telah dijelaskan sebelumnya. Maka
langkahselanjutnya adalah mengunggah data yang telah
diedit.
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Maka klik Send to GPS

atau iKon

4. Maka akan muncul

3 Sesuzikan dengan

merek dan seri GP

b. Maka jika berhasil, akan terupload ke GPSnya.
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PETUNJUK DUITASI MENGGUNAKAN OPEN
STREET MAP

1. Pendahuluan

OpenStreetMap adalah peta dunia yang berlisensi open
source/gratis yang membutuhkan koneksi internet untuk
mengaksesnya. Cara kerjanya seperti Wikipedia, Setiap orang
dapat mendaftar/registrasi kemudian = menambahkan
informasi pada peta, memperbaiki/mengedit kesalahan yang
ada dan memetakan apa yang akandipetakan. Saat ini telah
ada 500.000 orang di dunia yang sudah memiliki akun.

Hasil dijitasi anggota di seluruh dunia dapat diunduh secara
gratis di alamat http://download.geofabrik.de/. Sebuah WEB
yang menyediakan data gratis hasil dari keaktifan anggota
OpenStreetMap yang melakukan perbaruan/updating peta
secara online. Datanya memiliki beberapa format
diantaranya shapefile (*.shp), OSM (*.osm.pbf) dan OSM
(*¥osm.bz2). Tampilannya sebagai berikut.

Clice on the g tare 10 e the ovevieny page for that vgicn, or select one of the s eviensiion ioks for quek scoess

Subi-Region G Quick Links
.osm.pbf shp.zip nsm.bz2

KE KK XKD

Langkah pertama-tama untuk dapat menggunakannyaadalah
mendaftarkan diri anda (sign wup).atau juga dapat
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mengunduh tutorial untuk melakukan registrasi dan editing
peta. Langkah-langkahnya sebagai berikut :

a. Cek koneksi internetnya. Kemudian buka browser di
dalam laptop yang digunakan. Masuk ke alamat

http://www.openstreetmap.org
- = ;

§ ity o o o
i Bt
f

or e e i U T e el
Jika berhasil, maka akan muncul jendela isian yang wajib diisi
sebagai berikut:

nalamat email dan

1asi email

ey —

Bl et
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Jika berhasil, maka akan muncul jendela konfirmasi aktivasi
melalui email yang tadi diisi.

Check your email!

We sent you a confirmation email. Confirm vowr account by cliciong on the link i the emad and
you'll be able to start mapping.

b. Masuk ke email yang tadi diisikan. Kemudian klik link
yang dikirimkan oleh OpenStreetMap. Maka akun sudah
aktif.

OpenStreetiap <iwshd

4 e

feEimaf o> 00:14 (20 rinutes aga) e

Hi thers!

Semesne (hopefully you) just created an account at y

Before we do anything else, we nezd to confirm that this request came fram you, £o if it did then plezse click the link balow to canfirm
your account:

+Satda Ulzonfite?eonfim st

2. Memulai Dijitasi On Screen

Dijitasi pada OpenStreetMap dapat berupa titik, garis dan
poligon. Hasilnya akan tetap berada di web sebagai database
spasial yang berlisensi gratis yang legal untuk diunduh oleh
masing-masing orang. Langkah-langkah dijitasinya sebagai
berikut :

a. Log in terlebih dahulu. Isikan Username dan

Passwordnya
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Login

Dord have &

Email Address or Username:

Password:

2 Remember me

Jika berhasil maka akan muncul username di pojok kanan

atas.

b. Mulailah menggeser petanya ke lokasi yang akan
didijitasi.

BT s, ko i

g L 5 o

Baiion [ —
pr—
e

s .

W i o ek

b s

c. Klik Menu Edit - Edit With ID (in browser editor)
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Edit > Edit With1D
{in browser editor}

T

Maka akan muncul kotak dialog sebagai berikut

- s s /_
4 & Wity il o 0tk ¥ it 1 ot A0 WOk g YRR NGty

L34 ot oo Fiiiemation Se ncor o s repel Ry b ot pies

W

Jika berhasil, maka akan masuk pada lembar kerja editing
sebagai berikut. Tipe data dijitasi di OpenStreetMap terdiri
dari titik, garis dan poligon.

2.1. Memulai Dijitasidengan Tipe Data Titik
Untuk memulai mendijitasi dengan tipe data titik diperlukan
langkah-langkah sebagai berikut:
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Setalah log in sesuai dengan username, maka mulailaih
mendigit titik dengan mengklik pada tombol POINTatau

© Point

g Yy
L
9699 900 0W000T,

s

e

S
> %

b. Jika sudah mendigit titik maka akan secara otomatis web
akan memunculkan kotak isian yang berisi nama objek
beserta atribut pendukungnya seperti berikut ini.

.

Q00 090 00109009

e GRG0

L -
g

»
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¢. Maka akan muncul kotak isian berikutnya seperti gambar
berikut ini

Edit teature x

PR
e Prace utworsiip i -

Adidrews

d. lJika sudah selesai mendigit maka klik save untuk
menyimpan data dijitasi. Data tersebut akan secara
otomatis terunggah di web dan dapat didownload
kapanpun.

Klik Save
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Jika berhasil maka akan muncul informasi bahwa data sudah
terunggah /terupload ke server OpenStreetMap.

2.2. Memulai Dijitasi dengan Tipe Data Garis
Langkah-langkah untuk mendijitasi dengan tipe data berupa
garis tidak jauh berbeda dengan langkah mendijitasi titik.
Langkahnya sebagai berikut :

a. Setalah log in sesuai dengan username, maka mulailaih
mendigit titik dengan mengklik pada tombol LINEatau

/ Line

lkon

b. Jika sudah mendigit garis dan menentukan pilihan tipe
objeknya, maka secara otomatis web akan memunculkan
kotak isian yang berisi nama objek beserta atribut
pendukungnya seperti berikut ini
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Edit featurs x

S K P

i Riwet

8. Tige objekyangdipilih

Klik Untuk menambabkan informasi

terkait shjek yang diplot Seperti
website, referensi sumber dil

c. Jika sudah selesai mendigit maka klik save untuk
menyimpan data dijitasi. Data tersebut akan secara
otomatis terunggah di web dan dapat didownload

kapanpun.

B e o ) ey )

melw s dvmiE s ‘ -

Jika berhasil maka akan muncul informasi bahwa data sudah
terunggah /terupload ke server OpenStreetMap.
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2.3. Memulai Dijitasi dengan Tipe Data Poligon
Langkah-langkah untuk mendijitasi dengan tipe data berupa
poligon atau area tidak jauh berbeda dengan langkah
mendijitasi titik dan garis. Langkahnya sebagai berikut :

a. Setalah log in sesuai dengan username, maka mulailaih
mendigit titik dengan mengklik pada tombol AREA atau

lkon

. Setelshr

maka akan

b. lJika sudah mendigit garis dan menentukan pilihan tipe
objeknya, maka secara otomatis web akan memunculkan
kotak isian yang berisi nama objek beserta atribut
pendukungnya seperti berikut ini
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Edit roature X
Tipe objekyang dipitih
=i
\ 5, Nama Objek
Moy Alarnat Objek
levasi Objek
Esovation

KhikUntuk menan an informasi

terkaitobjek yang di Seperti

website, referensi sumber dil

c. Jika sudah selesai mendigit maka klik save untuk
menyimpan data dijitasi. Data tersebut akan secara
otomatis terunggah di web dan dapat didownload
kapanpun.

Jika berhasnl maka akan muncul lnforma5| bahwa data sudah
terunggah /terupload ke server OpenStreetMap.
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3. Mengunduh (Download)Data Hasil Dijitasi Open
Street Map

Untuk mengunduh data hasil dari dijitasi yang dilakukan

oleh pemilik akun Open Street Map dapat diunduh di

alamat web, yaitu http://download.geofabrik.de/. Dengan

tampilan seperti berikut:

OpenStraetMap Data

B s St S

1 T 2
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Jika berhasil maka komputer akan mengunduh hasil
dijitasiseluruh pemilik akun yang ada di Negara tertentu.

Catatan : Data yang diunduh di web tersebut tidak secara
otomatis merupakan hasil updating dari pemilik akun
secara real time namun di perbaharui/update secara
berkala
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PETUNJUK PENGOLAHAN DATA
MENGGUNAKAN ARCGIS

1. Pendahuluan

Untuk menampilkan data GPS vyang telah diunduh
menggunakan software easy GPS dan disimpan dengan
format *.gpx maka langkah selanjutnya untuk menampilkan
di software Arc GIS membutuhkan tools tambahan, yaitu
GPS_File_to_SHP. File mentahnya dapat di download pada
link di bawah ini.

http://resources.arcgis.com/gallery/file/map-
templates/details?entrylD=BCO61D5E-1422-2418-7FCE-
CCOFBBOC0825

Link tersebut merupakan link dari penyedia atau pembuat
software arc GIS yang sudah banyak dikenal umum dengan
nama ESRI.

Cara untuk mengunduhnya mudah, tinggal mengklik tombol
Download maka file akan langsung terunduh dengan format
winzip.

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 4

Corvert GPS Fries (XMA, GFX, WPT, BLT) 10 Shapefiles

fTirRp— [——
BRABHRLT

e

2. Mengaktifkan Tools GPS_File_To_SHP

Setelah mengunduh tools yang diperlukan untuk
mengkonversi data dari format *.GPX menjadi data dengan
format *. SHP. Maka langkah selanjutnya adalah
mengaktifkan tools tersebut. Langkahnya sebagai berikut :

a. Buka folder temat penyimpanan tools yang tadi diunduh
b. Extract file yang berfomat winzip

SRR e
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¢. Untuk menjadikan tools ini permanen di software Arc GIS
ketika dibuka di lain kesempatan. Maka isi file yang ada
di dalam folder GPSFile_to_SHP harus dipindahkan
terlebih dahulu di C:\Program Files
(x86)\ArcGIS\Desktop10.1\ArcToolbox\Toolboxes.
Seperti di bawah ini

| ety vk

o e
* B rom s
e
g 5 e
P timnd
s Sampmstacbiivaie
P
WP 9P it S o0
Qo e
[

P i

i

Maka hasilnya akan seperti di bawah ini. File yang sudah di
download sudah menyatu dengan arc Toolbox yang lain.

° Geostatistical Analyst Tools.tbx 9/7/2010 4:24 PM ArcGIS Toolbox 35KB

82 opx_to_shp.py 4 Python File
I8 il to_shp.py 9/10/2010 2:41 PM  Python File
0 Linear Referencing Tools.thx 11/18/2004 7:09PM  ArcGIS Toolbox 12KB
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d. Selanjutnya adalah membuka Software Arc GISnya

Eaardil,
e —
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Untuk memunculkan tools GPS_File_To_SHP ke dalam arc
toolbox caranya sebagai berikut:

& Untitled - Archtap

BERERAPIBERIRUB RIS

. Im;-mu )

LA Wwohox [ s 8e) tn B

| Wi s o cany ey Bcoenn v
%uf OB
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& @@ 30 Analyst Tools
& @ Analysis Tools

& @ Cartography Tools
# 1 Conversion Tools
5 ) Data Interoperabiity Tools
5 1 Data Management Took

& R Editing Toois

8% Geocoding Tools ‘
& &P Geostatistical Analyst Tools &

% 1 Lnear Referencing Tools % QY Linear Referencing Tools
& T Muttdmension Tools rﬁznmmmgk

Netwark Analyst Tools & & Network Analyst Tools
ot - 1 51 Parcel Fabric Tools

& @ Parce! Fabric Tools

5 &Y Schematics Tools % @Y Schematies Tools

(¥ Kg Server Tools # Server Tools
Spatial Ainalyst Tools ® wmsnods

% @ Spatial Statistics Tools % R Spatial Statistics Tools

® 8 Tracking Analyst Taoks & W Tracking Analyst Tools
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3. Menampilkan File dari GPS ke Arc GIS

File yang sudah diunduh menggunakan software easy GPS
masih berfomat *.GPX. Jadi belum bisa ditampilkan secara
langsung ke dalam software Arc GIS. Sehingga mmerlukan
tools yang tadi ditambahkan ke dalam arc toolbox. Langkah
untuk menampilkan datanya adalah sebagai berikut:

a. Buka software arc GISnya dan tampilkan arc toolboxnya

SILEEIREONY

b. Selanjutnya adalah memanggil data *.GPXnya dengan
bantuan toolbox
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i

ermom sconera: NN |

c. Selanjutnya adalah menentukan Tipe data yang akan
dikonversi, yaitu titik atau garis. Jika memilih point
berarti akan mengambil hanya titik saja (Waypoint)yang
ada di dalam file *.GPX. Sedangkan jika memilih Polyline
maka berarti mengambil data trackinganya saja.
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d. Jika berhasil, maka akan file *.GPX akan terkonversi
menjadi data *.SHP atau Shapefile dan dapat diedit di
dalam Arc GIS.

4. Menambahkan Basemap

Software arc GIS memiliki fitur tambahan, yaitu dapat
menampilkan peta dasar/basemap, yang dapat dijadikan
sebagai latar belakang peta yang akan dibuat. Namun
memiliki syarat harus terkoneksi dengan internet yang cuup
kencang. Langkah menampilkannya sebagai berikut :

a. Buka dokumen arc GISnya

Maka jika berhasil akan tampil sebagai berikut:
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5. Dijitasi & Editing di Arc GIS

5.1.  Dijitasi di Arc GIS

Untuk dapat melakukan analisis dengan menggunakan
software SIG, data yang dibutuhkan adalah data vektor.
Data vektor dapat diperoleh dari instansi-instansi yang
menerbitkan atau dengan membuatnya berdasarkan peta
hardcopy dan citra satelit.

Dalam bagian ini akan dijelaskan mengenai pembuatan data
vektor berdasarkan data citra satelit atau peta hardcopy
yang sudahdi-scan terlebih dahulu. Dijitasi secara umum
dapat didefinisikan sebagai proses konversi data analog ke
dalam format digital. Objek-objek tertentu seperti jalan,
rumah, sawah dan lain-lain yang sebelumnya dalam format

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 4

raster pada sebuah citra satelit resolusi tinggi dapat
diubah kedalam format digital dengan proses dijitasi.

5.1.1. Metode Dijitasi
Proses digitasi secara umum dibagi dalam dua macam:

1. Dijitasi menggunakan digitizer, dalam proses digitasi
ini memerlukan sebuah meja dijitasi atau digitizer.

2. Dijitasi onscreen di layar monitor, dijitasi onscreen
paling sering dilakukan karena lebih  mudah
dilakukan, tidak memerlukan tambahan peralatan
lainnya, dan lebih mudah untuk dikoreksi apabila
terjadi kesalahan.

5.1.2. Membuat Shapefile Baru

Shapefile baru dapat dibuat di ArcCatalog, yang akan
digunakan untuk membuat features classes (yang dapat
dibuat pada ArcMap) dan harus mendefinisikan type features
tersebut, Point, Line, atau Area (Polygon).

Langkah-langkah membuat shapefile baru :

a. Buka Arc GISnya
b. Klik ikon arc Catalog
c. Arahkan ke folder tempat penyimpanan

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 4

R sooee
# E20MAI Aoy,
H KT A Sobngitt Frowst 7 "

i G PRATIGE, G5 K
GO

d. Maka selanjutnya adalah membuat shapefile baru
dengan cara :
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Maka akan muncul kotak isian sebagai berikut
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Maka jika behasil akan tampil pada lembar kerja seperti di
bawabh ini:

Catatan : Untuk membuat shapefile baru selain titik.
Langkahnya sama seperti pembuatan shapefile baru seperti
di atas, hanya pada saat pemilihan type datanya pilih tipe
yang sesuai dengan yang dikehendaki seperti (Polyline,
Polygon).

5.1.3. Memulai Dijitasi

5:1.3.1. Dijitasi Titik

Sebelum memulai dijitasi, ada hal yang perlu diperhatikan
bahwa setiap mendijitasi suatu shapefile harus diawali
dengan start editing dan diakhiri dengan stop editing.
Langkah-langkah untuk memuai dijitasi sebagai berikut :

a. Untuk memulai dijitasi perlu pengguna perlu
mengaktifkan ekstensi EDITOR. Caranya sebagai berikut :
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Untuk mengaktif]
sebagai berikut

c. Selanjutnya adalah melakukan dijitasi dengan cara

wer

memilih layer yang akan didijitasi
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e. lJika sudah selesai melakukan dijitasi. Klik Editor = Stop
Editing
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5.1.3.2. Dijitasi Garis

Untuk mendijitasi data shapefile dengan tipe garis,
langkahnya sama seperti dengan langkah mendijitasi pada
titik selain tipe datanya yang berbeda juga terdapat
beberapa hal yang perlu diketahui dalam mendijitasi garis.
Langkahnya sebagai berikut :

a. Panggil data shapefile baru yang telah dibuat dengan
menggunakan langkah yang telah dijelaskan sebelumnya.
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b. Selanjutnya adalah melakukan dijitasi dengan cara
memilih layer yang akan didijitasi

el W

c. Mulai mendijitasi garis. Pada dijitasi garis dapat
ditentukan berapa panjang garis yang akan didijit, dan
dapat menentukan arah azimuthnya. Langkahnya sebagai
berikut:
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d. Jika sudah selesai melakukan dijitasi. Klik Editor = Stop
Editing

Sy ik 10 Gave 7o wik i

5.1.3.3.  Dijitasi Poligon/Area

Prinsip dan langkahnya sama dengan dijitasi titik dan garis.
Namun hanya beberapa yang membedakan dan yang perlu
diketahui. Langkahnya sebagai berikut:

a. Panggil data shapefile baru yang telah dibuat dengan
menggunakan langkah yang telah dijelaskan sebelumnya.
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b. Selanjutnya adalah melakukan dijitasi dengan cara
memilih layer yang akan didijitasi

¢.  Mulai mendijitasi area. Pada dijitasi poligon dapat
ditentukan bentuk & jenis objek yang akan didijit,
diantaranya Rectangle, Circle, Freehand, Ellipse, Poligon,
Auto Complete Polygon, Auto Complete Freehand. Tipe
tersebut adalah untuk memudahkan pengguna dalam
menentukan
bentuk poligon yang dikehendaki tanpa harus mendijit
secara detil.

L B Crephts Pobrgn
7l Bk Complete Frashand
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d. Selain itu juga pada dijitasi poligon dapat menentukan
panjang dan arah sudut poligonnya berdasarkan sudut
azimuthalnya

e. Jika sudah selesai melakukan dijitasi. Klik Editor = Stop
Editing

5.2.  Editing di Arc GIS
Kesalahanpadadigitasi garis
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1. Over Shoot
Kesalahaniniterjadiapabilaterdapatduagarisyangtidakterhub
ungtetapi salingberpotongan

ey

2. UnderShoot
Kesalahan ini
terjadiapabilaterdapatduagarisyangtidakterhubung

i

MengeditkesalahandenganfasilitasAdvanceEditing. Ini
merupakan salah satu extensi tambahan di dalam Arc GIS
yang berfungsi untuk melakukan pengeditan data spasial
(titik, garis dan poligon) tingkat lanjut.

Untukmengatifkantoolsini,klikmenu customize - toolbar =
advanced editing

1 2 3 45 6 7 8 9 101112 1314

Keterangan :

1. Copyfeaturetools

- Membuatsalinandatayangterseleksi didalam layer

yangsedangdiedit
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2. Fillettool.
- Membuatkurva/bentuksudutyangmelengkungdi

antaraduagaris

3. Extendtool

- Menghubungkansuatugariskegarisyang lain

4. Trim tools '

> Memotonggarisyangberpotongandengangarisyangl
ain
5. Line Intersection ”T ->Menyambungan dua segmen

garis yang tidak terhubung

6. Explode Multipart Featur
- Memisahkanmultipartfeaturemenjadifeatureterpis
ah

7. Construct Geodetic>Membuat garis atau poligon
dengan ukuran yang dapat ditentukan dengan mengacu

pada kelengkungan bumi

8. Align To Shape - Menyejajarkan fitur garis dan
mentrace sepanjang bentuk fitur yang ada. Peta ini
menunjukkan buffer yang memiliki toleransi dan preview
hasilnya.

9. Replace Geometry Tools—>Mengganti seluruh bentuk
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titik, garis, poligon dengan tetap menjaga nilai-nilai
atributnya. Snap atau Trace untuk menyamakan bentuk

baru dengan fitur lainnya.

7

10. construct  Polygon f‘-’-i-7‘Membuat poligon

berdasarkan garis atau poligon yang menjadi target.

11. split Polygons 1> membagi poligon atau poligon

yang tumpang tindih (Overlapping) menjadi beberapa
bagian dengan ukuran yang dapat ditentukan

1> membagi garis atau garis yang

12. pignarize line

tumpang tindih (Overlapping) menjadi beberapa bagian

dengan ukuran yang dapat ditentukan

13. Generalize == Mengenaralisir seluruh feature

yang ada dengan toleransi tertentu

14. Smooth “>Memperhalus bentuk feature yang

terseleksi dengan toleransi yang dapat ditentukan

Jikaprosesdigitasitelahselesaidilakukanmakalangkahselanjut
nyaadalah  pengisiantabel ataudataatributpetatersebut.
Untuk menampilkan data atribut klik kananpada theme
yang akan
ditampilkandataatributnyakemudianpilihopenattributetable.
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Maka akan muncul pilihan menunya seperti di bawah ini

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 4

Find & Replace > Mencarisuaty data pads table kemydian
Select By Attributes -> Mensglect data berdasarkan suatu
criteria tertentu /menselect semya data

Clear Selection > Unselectsemug data

Switch Selection > Menukar. atay menvelsksiylang fitur
yanglglah terseleksi

Select All > Menygleksisemug data

Add Field > Menambahkan kolom rada tabel

Turn All Field On > Menghidunkan semua kelam vang ada
Show Field Aliases > menampilkan alias darimasine-masing
lusiul kolom,

Arrange Tables > Menyusun tabel

Restore Default Column Widths 2 Mengembalikan lebar
kolemsenettisemula

Restore Default Field Order 2 Mangambalikan kelom
sepstiisehslumdigdit

Join and Relates -> Join tabsl & koneksi antar tabe)
Related Tables >mpenampilkan fabel vane telah tetkpneksi
dengan alribut tabsloya

Create Graph ->Membyat grafik dari data atribut vang

Add Table te Layout > Menampilkan tabel pada layout petz
Reload Cache > Mengisi kemball data yang tersembunyi
Print -> Mancstak Tabel

Report > membust format laporan dari data afribut
Export 2 Menyimpan table ke dalam format ang lain
Appearance > Mengatur property tabel

Kemudian Jika anda klik kanan mouse anda pada saat berada
pada judul masing- masing kolom maka anda akan
mendapatkan menu :

Ji Sort Ascending > Mengurutkan dari bawah ke.afas

__| Sort Descending -> engurytkan dari ates ks bawah

Advanced Sorting > Manguryikan tahg! sesual

| keinginan

Summarize > Membugt table bary daritable vang ads

Statistics > Pechitungan statistic

Field Caleulator 2 melakuken kalkulasi pada kolom

Calculate Geometry -> kalkulasi shapenys luss. di}

| TurnField Off > Menanaktifken Kalom

| Freeze/Unfreeze > Mewmindsh kolomvane terseleksi
Delete Field > Menghapus kolom

Properties - mengatur prongrtikolom
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Sebelum kita memulai mengisi data atribut, terlebih dahulu
kita harus menentukan “identifier” untuk masing-masing
record (objek).

Identifier/primary key berfungsi sebagai sebuah kode yang
unik untuk masing-masing feature, sehingga tidak akan ada
duplikasi data atau kesalahan pengetikan (error input)

Sistem pemberian kode identifier terbaik adalah dengan
menggunakan kode numerik, karena sistem database sangat
sensitif terhadap “lower case” dan “upper case” dari kode
string.

Contoh :
Batas Provinsi : 10
Batas Kota/Kab : 11

Dengan sebelumnya melakukan menambahan field atau
kolom pada atribut dengan sebelumnya memastikan kondisi
tidak dalam posisi strat editing untuk menambah field.

Berikut langkah untuk membuat field baru;
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iskieSoale Range
e
.""’:"... e
Label Sestares.

Joins and Relates
Refated Tables

Kemudian lakukan seleksi feature yang di shapefile yang akan
ditambahkan atributnya.

RAR#QIen
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Pada Atribut table klik “Selected”, maka akan tampil hanya
record feature yang terpilih. Pada judul field “ID” klik kanan,
pilih “field calculator”. Ketikkan kode batas administrasinya
(10, 11, dst), kemudian klik OK.

Benme Untrease Coamen,

S L 2

R Oeue il " .

4 Fmpomer. £ [ S ‘j Ketik angka 10 {karenaline
tmed | FEBtUTE yaNg ter-select

-|_merupakan batas provinsi}

Pilih OK

Maka field “ID” akan terisi nilai kode batasnya

Catatan :

1. Jika editing menggunakan Field Calculator tanpa diawali
dengan mode START EDITING maka hasilnya tidak bisa di
Undo atau permanen dan berlaku sebaliknya

2. Jika tipe datanya berupa TEXT, maka ketika
menggunakan FIELD CALCULATOR pada saat
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melakukannya harus diawali dengan tanda petik (“) dan
diakhiri dengan tanda (“)

6. Simbologi & Penyajian Peta

6.1. Simbologi

Simbologi merupakan salah satu unsur-unsur di dalam ilmu
kartografis yang berfungsi untuk merepresentasikan bentuk
dan kenyataan yang ada di lapangan dengan menggunakan
simbol/tanda yang mudah dimengerti oleh pembaca peta.
Simbologi pada peta terdiri dari beberapa jenis menurut
bentuk, sifat dll. Simbol peta menurut bentuknya terdidi dari

a. Simbol titik = simbol yang merepresentasikan sebuah
lokasi atau sebaran. Misalnya : stasiun, kota, kecamatan,
kabupaten, gunung, terminal, dll
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ibu kota negara

ibu kota provinsi

ibu kota kabupaten/kota
kecamatan/kota lain
pelabuhan

bandar udara

gunung api tidak aktif/mati
gunung berapi
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b. Simbol garis 2 simbol yang merepresentasikan sebuah
kenampakan segmen garis, seperti : jalan, sungai, dl|

4
::7&”\\ Sungal

jahan rays
juban lsin doss
EEReneRes bulag Nogers
S debots  haltas propinst

e gl itierch

Simbol area/poligon = simbol yang merepresentasikan

sebuah kenampakan area, seperti wilayah teritori,

administrasi, dll

Danau
Rawa
Sawah

Formasi

Batuan Kapur

Software Arc GIS juga memiliki jenis-jenis simbol yang dapat
disesuaikan dengan kebutuhan. Seperti Grafik, Diagram,

Piktorial, dll.
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Untuk dapat memunculkan dan mengatur simbol-simbol
tersebut langkah-langkahnya sebagai berikut :

a. Panggil data shapefile yang berupa titik, garis dan poligon
ke dalam lembar kerja. Posisi layer pada Table Of
Contentnya adalah sebagai berikut

Feature File Iypel

Wells Point

Seets  Line
LandUse  Polygon

Lakes
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b. Untuk mengatur ukuran dan warna secara keseluruhan,
maka caranya adalah sebagai berikut:

Maka hasilnya sebagai berikut
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c. Untuk mengubah simbol garis & poligon langkahnya
sama dengan mengubah simbol titik. Jika berhasil, maka
hasilnya akan tampak sebagai berikut:

S e

& @ guifer st 9
#O N
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6.2. Penyajian Peta

6.2.1. Layout diArc GIS

Sebelum pengguna membuat Layout Peta, pertimbangkan
dahulu apakah peta tersebut untuk dicetak atau
dipresentasikan.

Pertanyaan yang sering kali muncul :

1. Apakah peta tersebut merupakan bagian tersendiri
atau bagian peta yang berseri dengan peta lain
dengan desain yang serupa ?

2. Apakah ukuran kertas yang diinginkan saat peta akan
dicetak?

3. Bagaimana dengan orientasi kertasnya?

4. Bagaimanakah perbandingan skala peta yang cukup
informatif dengan ukuran dan orientasi kertasnya?

5. Elemen apa sajakah yang akan diinformasikan dalam
layout tersebut?

6. Apakah peta yang Pengguna hasilkan sesuai dengan
kaidah kartografis dan cukup informatif?

Jika peta tersebut merupakan peta yang berseri dengan
desain yang serupa, maka diperlukan template layout peta
Pengguna. Template layout memudahkan Pengguna dalam
membuat peta berseri dengan desain yang serupa dalam
sekali pekerjaan pembuataan templatenya. Menariknya,
Pengguna bisa membuat sendiri template tersebut sesuai
dengan desain yang Pengguna inginkan. ArcView juga
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menyediakan template untuk Pengguna dengan berbagai
pilihan dan Pengguna bisa memodifikasinya sesuai dengan
keinginan Pengguna.

Sebuah layout berlaku sebagai kanvas pada pelukis,
dimana hal ini memungkinkan pengguna untuk
merancang bagaimana menempatkan komponen dari
peta, mengaturnya sesuai dengan desain yang Pengguna
inginkan. Hal ini dapat dilakukan dengan dua cara yaitu
dengan menggunakan template yang ada atau dengan
melakukan desain sesuai dengan keinginan Pengguna
sendiri. Pengguna akan mempelajari kedua cara tersebut
dalam praktik pada bahasan ini.

Jika layout Pengguna merupakan peta yang berseri
dengan desain dan susunan tampilan yang baku pada
setiap layout, maka sebaiknya Pengguna menyimpan
desain layout Pengguna menggunakan template layout
yang tersedia di ArcMap. Peta berseri biasanya
merupakan kumpulan beberapa seri peta tematik dari
suatu geomer yang sama, misalnya Peta Administrasi
Kabupaten Bogor sebagai peta nomor 1 kemudian Peta
Kepadatan Penduduk Kabupaten Bogor sebagai peta
nomor 2 dan seterusnya. Peta-peta tersebut
menginformasikan Kabupaten Bogor sebagai geomer
dengan tema-tema tertentu. Peta berseri biasanya
memiliki perbandingan skala yang sama di setiap
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layoutnya.

Pembuatan layout dengan desain sendiri dimungkinkan
untuk dilakukan di ArcMap. Desain layout tersebut tetap
tidak boleh melupakan kaidah kartografis bagi tampilan
sebuah peta. Mengingat mendesain sebuah tampilan
layout merupakan persepsi keindahan (bisa dikategorikan
sebuah karya seni) dilihat dari sudut pembuatnya, juga
tidak boleh dilupakan informasi yang sesungguhnya ingin
disampaikan dari layout peta yang dibuat tersebut.

Desain layout yang dibuat sendiri itu pun, bisa Pengguna
simpan sebagai template layout tersendiri, dengan nama
template yang bisa Pengguna tentukan sendiri. Template
layout ini selanjutnya bisa Pengguna gunakan untuk
membuat peta tematik lainnya. Untuk menjadi catatan,
template layout yang Pengguna desain sendiri tersebut
hanya disimpan pada ArcMap Document (*.mxd) dimana
template layout tersebut dibuat.

Langkah-langkah untuk membuat layout peta sebagai
berikut:

a. Setelah di edit masing-masing jenis simbol (titik, garis
dan poligon) maka selanjutnya adalah masuk ke
halaman Layout dengan cara masuk ke menu VIEW->
LAYOUT VIEW
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Kemudian masuk dalam view layout, pilih View, kemudian

Layout Viewatau pindakan kursor pada bagian =R pada
bagian bawah

ndenty E}l‘.}u i

i A Cata Frvemm Prooatins,
o S s
I Pase Damicg "

@ BT Seweisveng
i [ PRI e Y “"”I

Sehingga tampilan layout akan nampak seperti gambar di
bawah ini.

Foedbet Sob SR
By i i 3
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b. Selanjutnya adalah pengaturan ukuran kertas

c. langkah selanjutnya adalah menambahkan element-
element peta seperti diantaranya : legenda, symbol arah
utara peta (a north arrow), title peta, skala bar, dan lain-
lain.

Tool untuk membuat element-element layout peta dalam
aplikasi ArcMap :

Pilih menu>insert=> Data Frame

File Edit View Bookmarks | Inset

& ) Wind Help

Legend...
Noth Arow...
Scale Bar...
Scale Ted...

GO > B

=
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Sebelum menambahkan legenda, kita harus melakukan
beberapa perubahan untuk text pada Table of
Contents.Langkah-langkahnya sebagai berikut:

= Pada Table of Contents, klik dua kali pada salah satu
layer

®  Ganti text Bangunan_Ul_Fix menjadi Fakultas,
kemudian enter.

oy

W FASTIOM
e
e
Wre
i
oy
e

il reora
Uit
W
WPt
B voxasy

= M Bangunan_UIL_Fix

Faculty

M Fasnkom

BB e

BEirn

i r1s

B

Brsr

B

Erpaes

ires1

L [y

B Posteknik

B vorast
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=  Atau cara lain, dengan menggunakan double klikpada
layer yang akan diubah kemudian pilih tab general ubah
namanya.

iy

Setelah itu, kita akan menambahkan legenda kedalam layout

e Dalam aplikasi ArcMap klik menu Insert>Legend.
e Kita terima defaults, klik tombol Next sampai selesai.
o Klik tombol Finish.

File  Edt  View Bookmarks

niy Sasle Text.
) victwre.

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 4

Pada kondisi defaults, setiap element — element layout yang
ditambahkan kedalam layout posisinya berada disekitar peta.
Kita pindahkan/geser ke posisi yang kita inginkan.

* Drag and drop legenda yang akan kita tempatkan.
= Perbesar / Zoom in legenda.

& M Fakultas
Faculty
MFASILKOM
Bre
]
mFe
mFiK
s
W @
EEFMIPA
bl
L Ly
B Polteknik
0 vokast
# [ quickbird_depok_full.t¢
# [J Basemap

18

17

i

Legenda masih dalam keadaan defaults. Kita akan
menghapus beberapa teks pada legenda, misalnya kita akan
menghapus teks pada bagian atas (heading) legenda.

= Klik 2 kali element legenda.
= Klik kanan, pilih properties.
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=  Pada Legend Properties Window, pilih tab Legend.
= Dibawah Title, uncheck pada check box Show.
= Klik tombol Apply.

KETERANGAN

Fakultas
Faouity
B suwon

Sebelum di hilangkan Sesudah diganti
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Jika kita bermaksud membuat peta untuk keperluan
pengukuran atau analisis jarak, maka skala bar ini penting
untuk ditambahkan sebagai element layout peta.

e Perkecil / Zoom Out tampilan layout, untuk melihat
tampilan layout secara keseluruhan.

e Klik Insert>Scale Bar.

e Pada window Scale Bar Selector, pilih dan klik Scale
Line 2.

e Klik OK.

File  Edit. View Bookrwrks  Insert

Dynamic Text
[ Nestiine..
Legend...

»?s:!: Picture...
f#l Object..

Pada kondisi defaults, setiap element — element layout yang
ditambahkan kedalam layout posisinya berada disekitar peta
. Kita pindahkan/geser ke posisi yang kita inginkan.

=  Drag and drop skala bar yang akan kita tempatkan.

= Klik kanan element Skala Bar dan klik properties.

= Pada window Scale Bar Properties, pilih tab Scale and
Units.

= Seting properties skala,

= Untuk Division value, missal Auto.
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= Untuk Number of divisions, missal 2.

= Untuk Number of subdivisions, missal 4.

= Check kotak Show one division before zero.

= Klik tombol Apply.

= Klik OK untuk menutup kotak dialog Scale Bar
Properties.

Selanjutnya adalah menambahkan arah mata angin, yaitu
North Arrow memberitahukan kepada pembaca/pengguna
peta mengenai orientasi dari peta.

Kita akan menambahkan symbol north arrow kedalam layout
peta.

e Klik Insert>North Arrow.
e Pilih ESRI North 48.
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e Klik OK.

3R heen 41 ESRTMRAR AR

5 Data Frame
e Title

A Ten
0
i:

Dypamic Tet  »

17 Sove 5o Moa

Eifite s SR oS

Kita akan menambahkan judul peta/title kedalam layout

peta.

e Pada toolbar Draw , pada bagian bawah ArcMap,
seting ukuran font dan jenis nya. Misalkan untuk font
pilih 30, dan untuk type pilih Arial.

e Klik tombol New Text, kemudian ketik judul Sebaran
Bangunan & Gedung di Ul
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Langkah selanjutnya adalah menambahkan grid koordinat,
yaitu dengan cara klik kanan pada layer kemudian pilih

properties ;

Sty -
TR A B g

3 s Va4

e P
1w 3908 o g S it
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| e O
a4

o

NGUNAN
RAGITAS INDONESIA

KETERANGAN

Bngunan
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Langkah selanjutnya adalah menyimpan data atau
mengexport data menjadi JPEG yaitu dengan cara;

o Klik menu File>Export Map.
e Ubah nama dan save

£ Map Dacomaent Progmbes..
§ CHAPER P elitihon L P8 v
1723 AEeFE

Simpan / Save dokumen peta yang baru kita kerjakan.

e Klik menu File>Save

Ctrb+n
Ctrl+O

Add Data >
ArcGIS Online..,

i i S
ik | Page and Print Setup...

Print Preview...
&
L

Print..,

§| Create Map Package...
ExpmMap, o s S
& Map Document Propertes...
1 DALPEM\Pelatihan LPEM.mud
e .
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Jika kita tidak akan melanjutkan pekerjaan kita menggunakan

ArcMap, keluar

dari ArcMap :

o Klik Menu Fi/e>Exjt.

@ Pelatinan
File | Edit View Bookmarks Insert §

!
2
@

New.,.

Open...

Ctel+N
Ctri+0

Save
Save As...

Save A Copy...

Ctrl+S |

Add Data »
ArcGIS Online...

Page and

Print Preview...

Print..,

Create Map Package...
Export Map...

Map Doc
1 D:ALPEMAPelatihan_LPEM.mxd

Print Setup...

ument Properties...

6.2.2. Menggunakan Aplikasi Tambahan Carry Map

CarryMap adalah solusi yang unik
untuk menyajikan peta dalam
format  *.EXE.  Sehinggaketika
dibuka di laptop lain, dimana
laptop tersebut tidak terinstall
arcgis maka tiggal di eksekusi dari
file tersebut. Namun CarryMap ini
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hanya bisa untuk menampilkan tidak dapat mengedit titik,
garis dan poligon layaknya di software ArcGIS.

Tetapi jika di laptop tersebut telah terinstal ArcGIS maka
format *.EXE tersebut bisa diextract kembali tampilannya ke
dalam ArcGIS.

CarryMap ini merupakan software berbayar yang dikeluarkan
oleh DataEast denga satu lisensi harganya sekitar $200 atau
sekitar 2 juta Rupiah. Tetapi untuk kepentingan akademis
software ini menawarkan student license atau gratis bagi
kepentingan akademis. Aplikasi ini dapat dibuka juga di
komputer desktop, Windows mobile, Apple iOS dan Android .

CarryMap ini merupakan Extensi terpisah dari ArcGlIS.
Sehingga untuk menggabungkan ke dalam ArcGIS harus
melalui isntalasi terlebih dahulu. Untuk mendapatkan file
instalasi software tersebut dapat diunduh di alamat
http://www.dataeast.com/en/carrymap.asp
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6.2.2.1. Instalasi Software

i ey

Maka akan muncul jendela instalasi sebagai berikut :

Welcome to the CarryMap Setup
Wizard

ok etk Conryihog Tom Yoo compndee,

ey
Tk Nt 20 0ondanam, o Camon 00 w8 Sehup,
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Tunggu Sampai selesai FINISH instalasi. Maka Software telah
terinstall di laptop atau computer.

6.2.2.2. Mengaktifkan Software di ArcGIS
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6.2.2.3. Menggunakan CarryMap untuk Penyajian Peta
Untuk menampilkan tampilan peta dengan sedimikan rupa
simbol yang telah diubah sebelumnya dengan menggunakan
carrymap, langkah-langkah yang dilakukan sebagai berikut :
a. Buka dokumen ArcGIS yang telah diatur simbologinya

M Tingkat Biaya Hidup
Biava
<2 uta
) 2-3uts
Bl 3 -4 Juta
W > 4 Juta
# [0 Bangunan_UI selection

& [ Bangunan Ut
=
& [ quickbirc_depok_full.tf
& W New Data Fr. e W i
ales i o | ey oo
; ; b

b. Kemudian klik pada CarryMap pada toolbar CarryMap
yang telah diaktifkan

¥ B quckbid depck Rl o

# 47 M Data Frme
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Maka akan muncul kotak dialog sebagai berikut:
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stgeomimhin

Al ot

Maka jika berhasil, akan muncul file dengan format *.EXE
pada folder yang telah ditentukan sebelumnya
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Maka akan muncul tampilan sebagai berikut

| 7 Lagend { iseamn Bangunan Ul

1 [ Pushpins

Bangunan Ul
B rasikom
L B
o
B4 ri

i e

i wisw
£3 ERM
MR
8 =pa
| =

8 roliteknik
B vokast

F quickbind, depok full tif]

i 122805
i 106TABNE OGE §722'3698°S
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PETUNJUK PENGOLAHAN DATA
MENGGUNAKAN QUANTUM GIS

1. Pengantar Lunak Quantum GIS

Quantum GIS adalah sebuah perangkat lunak SIG Open
Source yang dapat dijalankan di dalam platform Microsoft
Windows, Linux, Unix, Mac OSX, dan Android. Perangkat
lunak ini dikembangkan mulai tahun 2002, dan saat ini
merupakan salah satu perangkat lunak SIG dengan
kemampuan dan fungsionalitas SIG yang paling lengkap
untuk  kategori perangkat lunak SIG open Source.
Quantum GIS terdiri dari beberapa modul, yaitu :

1. QGIS Desktop - Untuk input data, penampilan data,
query data, analisa data, dan presentasidalam
bentuk peta.

2. QGIS Browser - Untuk manajemen data.

3. QGIS Server - Untuk mengelola basis data spasial
dan layanan peta yang mendukung koneksi web
site.

4. QGIS Client - Framework Aplikasi GIS berbasis web
yang mengkonsumsi data dari Quantum GIS
Server.

Berikut ini adalah perkembangan software QGIS
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?I 1 (Enc#!adu%

?Start
Jan-02 Jany-OB Jan-04 Jan-05  Jan-06 Jan‘-07 mn.-OS lan-09  Jan-10 Jan-11
Versi terbaru tahun 2013 adalah QGIS 2.0 Dufour

Untuk mengunduh QGIS dapat mengunjungi alamat web

http://www.qgis.org/en/site/
QGIS

A Free and Open Source Geographic Information System

Create, edit, visualise, snslyse and publish geospatial information on Windows, Mac, Linux, 8S0 (Android coming soon)

Tor your desitop, sarser, it your web Srowser and a1 deveiopey boaiay

2. Instalasi Quantum GIS
Langkahnya sebagai berikut :

a. Buka file yang telah diunduh
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3. Pengenalan Quantum GIS Browser

Quantum GIS browser adalah salah satu bagian dari
guantum GIS yang berfungsi hampir sama seperti windows
explorer. berfungsi sebagai alat mencari data di dalam
dokument yang kita miliki dan manajemen data (copy,
paste, preview, delete).
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3.1. Tampilan Quantum GIS Browser
Buka Quantum GIS Browser pada desktop atau didalam
progam seperti tampilan diatas

b. Setelah itu folder yang berisi data shapefile

c. Pilih salah satu data yang akan dilihat dengan mengklik
data yang diinginkan , maka akan tampil seperti dibawah
ini;

4. Pengenalan Quantum GIS Desktop

4.1. Tampilan Quantum GIS Desktop

Quantum GIS Desktop terdiri dari dua modul utama, yaitu
Quantum Desktop itu sendiri dan Quantum GIS Browser.
Quantum GIS Desktop digunakan untuk penampilan data,
editing data, simbolisasi data, analisa data, dan pembuatan
layout peta.

1. Buka Quantum GIS Desktop Map dari Menu Start
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Programs>Quantum GIS>Quantum GIS Desktop 1.8.0

Faypersioy et Socisity 1003
Sl

Iaglits

Marine Gespaal Brrdogy Teol
Wmrzoott Sffice 201}

Maiseso Siveright

o WFres Caleg

: Metspydes

A0 Lorprranon
Qs GIELisbon

S
: TELRTAIE Freahy

2. Buka layer Batas administrasi depok dalam format
shapefile dengan cara klik tombol Add Vector layer

atau dari menu Layer > Add Vector Layer.
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3. Di pilihan Source Type pilih File, kemudian klik Browse,
Arahkan ke folder tempat data spasial yang akan
ditampilkan

4. Lakukan eksplorasi data dengan menggunakan tool
berikut ini dibawah. Kenali fungsi—fungsi seperti
zooming dan panning. Zooming bisa dilakukan juga
menggunakan mouse wheel.

Untuk Zoom Out

Untuk Zoom in
Untuk Zoom ke tampilan sebelum dan sesudah

Untuk menggeser peta Untuk Zoom ke layar penuh

5. Mengunduh & Menampilkan Data dari GPS
Setelah mengunduh data GPS menggunakan software Easy

GPS dengan format *.GPX, maka selanjutnya adalah
menampilkan data tersebut ke dalam software Quantum GIS
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dan menyimpannya menjadi data Shapefile. Langkah-
langkahnya sebagai berikut:

a. Buka Dokumen baru Quantum GIS

b. Kemudian ceklis data apa saja yang akan diunggah ke
dalam QGIS
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Layer tersebut belum menjadi data Shapefile. Sehingga tidak
dapat untuk diedit. Untuk mengkonversi menjadi data *.SHP
atau SHapefile caranya sebagai berikut :
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6. Dijitasi & Editing di QGIS

Data masukan dalam SIG pada dasarnya dapat dikategorikan
menjadi dua, yaitu data dijital dan data non dijital. Untuk
data dijital (terlebih yang mempunyai informasi geolokasi)
relatif lebih mudah di-input ke dalam SIG karena hanya
tinggal diimport saja. Sedangkan data dijital yang belum
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memiliki  koordinat perlu dilakukan proses pemberian
koordinat atau georeferencing. Selain itu terdapat jenis data
dijital yang walaupun sudah mempunyai koordinat belum
dapat digunakan secara langsung ke dalam SIG. Data tersebut
adalah foto udara dan citra satelit, dimana kedua jenis data
ini harus diinterpretasi dulu sebelum bisa menjadi data yang
siap pakai dalam SIG.

Teknik input data SIG dalam modul ini difokuskan pada dua
teknik input data saja, yaitu digitasi dan input data GPS.

6.1. Dijitasi On Screen

Digitasi on screen merupakan salah satu teknik input data
yang lazim digunakan dalam SIG. Disini peta atau citra satelit
yang menjadi sumber data/referensi ditampilkan di layar
monitor, kemudian operator melakukan proses interpretasi
dan deliniasi menggunakan alat yang disediakan perangkat
lunak.

6.1.1. Dijitasi Data Titik

1. Dari menu layer klik New > New Shapefile Layer.
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2. Untuk jenis feature, pilih point, kemudian klik specify CSR

3. Untuk mulai mendigit kenampakan titik, klik tombol
Toggle Editing atau klik kanan nama layer yang

akan diedit lalu pilih Toggle Editing
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pohon

4. Mulai digitasi dengan menggunakan tombol Add Feature

untuk menghapus hasil digitasi gunakan tombol
Se- lection lalu klik Delete @ untuk menghapus
hasil digitasi. Berikut ini adalah fungsionalitas lain dari
toolbar Editing Titik.

Jika sudah mendijit/ploting pada lokasi yang telah ditentukan
maka akan muncul kotak isian seperti berikut ini
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£ Attributes - Titik

Klik tombol save atau toggle editing untuk keluar dari
mode editing dan menyimpan hasil editing dan digitasi.

6.1.2. Dijitasi Data Garis
Untuk memulai dijitasi garis, langkahnya sama seperti dijitasi
pada titik. Langkahnya sebagai berikut :

1. Mulai digitasi dengan menggunakan tombol Add Feature

untuk menghapus hasil digitasi gunakan tombol
Se- lection [%F lalu klik Delete | untuk menghapus
hasil digitasi. Berikut ini adalah fungsionalitas lain dari
toolbar Editing garis.

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 5

2. Simpan hasil editing menggunakan tombol Save atau
Toggle Editing.

] { Stop editing

o

M

6.1.3. Dijitasi Data Poligon

Langkah selanjutnya, adalah proses menggambar atau dalam
hal ini diistilahkan sebagai digitasi on screen. Proses yang
akan kita lakukan ini adalah menggambar wilayah adminitrasi
kota bogor yang mengacu pada image
kota_bogor_georeference. Untuk memulai proses
menggambar, aktifkan Toggle Editing terlebih dahulu.
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Jika telah aktif, maka kita sudah dapat memulai proses
menggambar,select/aktifkanlayerdigitasi_poly_admin,
kemudian klik Add Feature, lalu gambarlah batas
administrasi kota bogor menggunakan mouse anda. Jika telah
selesai, klik kanan.

e NWE AN 3
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Maka akan muncul kotak attribute dimana kita perlu mengisi
ID polygon, isi saja 1, kemudian klik saja OK.

Maka polygon adimintrasi telah terbentuk. Matikan Toggle
editing untuk menghentikan proses editing, kemudian save
lah hasil digitasi.
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6.2.  Editing Di QGIS

6.2.1. Editing Data Poligon
Langkah selanjutnya adalah memotong polygon, mulailah
mengaktifkan Toggle editing kembali.

2.klik Toggle editing
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Proses memotong polygon ini sama halnya dengan
mendigitasi, syarat utamanya adalah kita dituntut untuk
menarik garis melebih batas polygon yang akan kita potong.

3.Mik/aktifkan lavernya

4 klik Split Features

(8 comtene i i
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Lakukan hingga semua batas kecamatan terpotong. Jka telah
selesai, klik Toggle editing untuk menghentikan proses edit,

kemudian save

5.klik Toggle Editing

i
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[ e —

Maka dapat terlihat pada layer digitasi_poly_admin telah
terpotong-potong menjadi polygon pollgon kecamatan.
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6.2.2. Inputing Atribut

Langkah selanjutnya adalah proses inputting attribute. Setiap
polygon tentu memiliki keterangannya atau dikenal sebagai
istilah data attribute.

Untuk membuka attributnya, berikut ini adalah langkahnya.
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Maka akan muncul tabel attrlbute darl dlgltaS| poly_ admm
Terdapat 6 record, dimana merepresentasikan 6 poligon yang
terdapat di dalam layer digitasi_poly_admin. Dalam sesi ini,
kita akan memberikan keterangan nama kecamatan di setiap
polygon tersebut
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Oleh karena itu, buatlah kolom baru, dimana kolom ini nanti
terisi nama-nama kecamatan untuk masing-masing polygon.

2,Klik New Coloumn

T

~ 3.Berinamalksolom sghagal KECAMATAN 1

. \{ 4 Jipg data gy,g[;);_Text l

i

5.Jumizh karakter = 30 [

Untuk memudahkan pengisian, sandingkan kotak tabel
attribute dengan map view seperti gambar di bawah ini.
Kemudian, klik toggle editing pada kotak table attribute,
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kemudian double klik di salah satu record, hingga polygon
terselected warna kuning, kemudian, isilah nama kecamatan
dengan mengacu pada letak polygon yang terselected
tersebut.

T8 Viee S W S Wiar S Diwe sl

| polygon yang diraksud

Isilah semua poligon dengan keterangan kecamatannya, jika
selesai, klik toggle editing kembali untuk menghentikan
proses edit, kemudian save.

numtiﬁwmwmufv»”
mwmoaosrmxoawiw
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9.isilah nama kecamatan dari

polygon yang dimaksud

B -
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7. Simbologi &Layout di QGIS

7.1. Simbologi

Simbologi merupakan salah satu unsur-unsur di dalam ilmu
kartografis yang berfungsi untuk merepresentasikan bentuk
dan kenyataan yang ada di lapangan dengan menggunakan
simbol/tanda yang mudah dimengerti oleh pembaca peta.
Simbologi pada peta terdiri dari beberapa jenis menurut
bentuk, sifat dll. Simbol peta menurut bentuknya terdidi dari

a. Simbol titik 2 simbol yang merepresentasikan sebua
lokasi atau sebaran. Misalnya : stasiun, kota, kecamatag,

kabupaten, gunung, terminal, dll
11.Klik save
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1l

ibu kota negara

= ibu kota provinsi

= ibu kota kabupaten/kota

= kecamatan/kota lain
pelabuhan

= bandar udara

= gunung api tidek aktif/imati
= gunung berapi

Pro©@c ool

b. Simbol garis 2 simbol yang merepresentasikan sebuah
kenampakan segmen garis, seperti : jalan, sungai, dll

X
e X
i ~ Sungai

e

o

jaken raya
jutan tain dess
Prbebseeed  balug negara

Sebotutpibots batus propinst

T At o werah

c. Simbol area/poligon >simbol yang merepresentasikan
sebuah kenampakan area, seperti wilayah teritori,
administrasi, dll

Danau
Rawa

Sawah

Formasi
Batuan Kapur
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7.1.1. Single Simbol

] Batas. 3o bamwdian

3. BlKOK

Berikut hasil single simbol ;

ot il
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7.1.2. Categorized Simbol

o
Pancoran Mas Pancaran Mas
Sowigen  Sawangan
Sumgns  Sohngem
Tapos g7

Berikut hasil categorized simbol, berdasarkan kecamatan di
Kota Depok;
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7.1.3. Graduated Simbol

Berikut hasil grauduated simbol, kepadatan penduduk di
Kota Depok
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7.1.4. Chart

Setelah berubah data spasial sesuai dengan warna, cara lain
untuk menampilkan visualiasi data spasial adalah dengan
menggunakan chart, berikut langkah-langkah yang dilakukan

’

Maka akan muncul menu berikut ini:
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berikut hasil chart dari jumlah penduduk laki-laki dan
perempuan;

JBHUS L RRPPPFPLUGBP T 7 i1
sahadeININ «g0d ki ;
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7.2. Layout di QGIS

Setelah melakukan pengaturan pada simbologinya maka
selanjutnya adalah melakukan layout atau tata letak peta.
Langkahnya sebagai berikut :

1. Buka Print Composer melalui menu File > New Print
Composer.

2. Modul Print Composer akan ditampilkan. Atur ukuran
kertas di panel sebelah kanan menjadi ukuran A4 dengan
orientasi landscape. Selain itu centang juga pilihan Snap
to Grid.
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3. Kita akan membuat garis tepi (neatline) terlebih dahulu,
Klik tombol Shape, kemudian pilih Add Rectangle, lalu
drag and drop mulai dari kiri atas ke kanan bawah.
Untuk mengatur tebal tipis garis, Klik Shape Added di
Command History menu, kemudian buka tab item
properties, lalu ganti ketebalan garisnya.

4. Klik tombol Add Map, kemudian drag and drop dari kiri
atas ke kanan bawah. Atur posisi agar irip seperti gambar
dibawah ini

PEDOMAN PEMETAAN SEJARAH DAN NILAI BUDAYA



Lampiran 5

Fiie View. lagout

Al aFESoRAAAO R s T BB

5. Di panel sebelah kanan bawah, klik Grid. Submenu Grid
akan diexpand, centang pilihan show grid dan draw
anno- tation, atur parameter interval koordinat x dan y
seperti gambar di bawah. Annotation position di posisi
outside frame, dan Annotation direction di posisi
Boundary direction. Hasil akan Nampak seperti gambar
di bawah.
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6. Langkah berikutnya adalah memasukan judul peta. Klik
Add Label, kemudian drag and drop di tempat kosong di
lembar peta. Untuk mengedit konten label dilakukan di
panel label sebelah kanan. Tombol Font dan Font Color
Berfungsi untuk mengatur warna, jenis, format, dan
ukuran font. Atur Horizontal Alignment di Center dan
Verti- cal Alignment di Middle. Selanjutnya Klik General
Options.
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7. General Options untuk mengatur frame dari label,
hilangkan centang pilihan show frame. Hasil akan
Nampak seper- ti gambar di bawah.
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8. Tahap berikutnya adalah memasukan North Arrow atau
tanda arah klik add image klik ruang kosong di peta.
QGIS akan me-load template north arrow di panel
sebelah kanan. Pllih jenis North Arrow yang diinginkan.
Untuk memperbesar dan memperkecil ukuran gambar
bisa dilakukan menggunakan width and height di
sebelah kanan, atau di klik drag di sudut gambar.
Tambahkan huruf “U” di atas north arrow menggunakan

oo SR N

e

iy, send 1o Bacy
s

9. Tahap berikutnya adalah memasukkan legenda. Klik add
legend, kemudia drag and drop di tempat yang kosong.
Gunakan panel di sebelah kanan untuk mengatur
parameter legenda. Tab General untuk mengatur Judul,
font, dan spasi legenda, tab Legend Items untuk
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mengatur layer—layer yang akan dimunculkan di
legenda, tab General Properties untuk mengatur frame
legenda. Atur seperti gambar di bawah. Hasil akhir
seperti gambar di bawah.

Menghapus layer

Menurunkan dari kgenda
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Menaikkan Menambah layer
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10. Langkah berikutnya adalah memasukkan Skala Grafis. Klik
Add Scale, kemudian klik ruang kosong dipeta, scale bar
akan ditampilkan. Klik Scale Bar Properties di sebelah
kanan untuk mengatur property dari scale bar. Kemudi-
an untuk menghilangkan garis tepi dari skala, klik Tab
General Options di bawah tab Scale Bar, kemudian atur
sep- erti gambar di bawah. Hasil akhir peta seperti
gambar di bawah.

7.2.1. Export Peta

Langkah terakhir adalah mencetak peta atau mengeksport
peta ke dalam format gambar (jpeg, tiff, png, bmp) atau PDF,
yang nantinya agar peta dapat ditampilkan di media lain
sesuai kebutuhan. Untuk mengeksport dari menu File di
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Modul Print Composer, klik Eksport kemudian pilih format
yang akan digunakan.

{4 Composer 2
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